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ABSTRACT

Over the past several years, the National Aeronautics and Space Administration

(NASA) has studied a variety of mission scenarios designed to establish a permanent

human presence on the surface of Mars. Nuclear Electric Propulsion (NEP) is one of the

possible elements in this program. During the initial stages of vehicle design work,

careful consideration must be given to, not only the shielding requirements of natural

space radiation, but to the shielding and configuration requirements of the on-board

reactors.

In this work, the radiation transport code MCNP has been used to make initial

estimates of crew exposures to reactor radiation fields for a specific manned NEP vehicle

design. In this design, three 25 MWth, scaled SP-100-class reactors are shielded by three

identical shields. Each shield has layers of beryllium, tungsten, and lithium hydride

between the reactor and the crew compartment. Separate calculations are made of both the

exiting neutron and gamma fluxes from the reactors during beginning-of-life, full-power

operation. This data is then used as the source terms for particle transport in MCNP. The

total gamma and neutron fluxes exiting the reactor shields are recorded and separate

transport calculations are then performed for a 10 g cm -2 crew compartment aluminum

thickness. Estimates of crew exposures have been assessed for various thicknesses of the

shield tungsten and lithium hydride layers.

A minimal tungsten thickness of 20 cm is required to shield the reactor photons

below the 0.05 Sv y-1 man-made radiation limit. In addition to a 20-cm thick tungsten

layer, a 40-cm thick lithium hydride layer is required to shield the reactor neutrons below

the annual limit. If the tungsten layer is 30-cm thick, the lithium hydride layer should be at

least 30-cm thick. These estimates do not take into account the photons generated by

neutron interactions inside the shield because the MCNP neutron cross sections did not

allow reliable estimates of photon production in these materials. These results, along with

natural space radiation shielding estimates calculated by NASA Langley Research Center,

have been used to provide preliminary input data into a new Macintosh-based software

tool developed at Texas A&M. A skeletal version of this tool being developed will allow

rapid radiation exposure and risk analyses to be performed on a variety of Lunar and Mars

missions utilizing nuclear-powered vehicles.
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CHAPTER I

INTRODUCTION

INTRODUCTION

Manned space flight began more than 30 years ago with single crew-member

vehicles like the Mercury capsule. Today, the National Aeronautics and Space

Administration (NASA) t is making plans for a manned space station scheduled to be

launched later this decade. During the late 1980s, a lunar base was being planned for the

following decade, and a manned mission to the planet Mars for the decade after that.

These latter activities would have required individuals to remain in space for years at a

time. An open question is what kind of radiation protection must be provided for humans

during such long exposures to space radiation hazards. As a consequence, the resources

devoted to the space program must include the protection of the astronauts and an

understanding of the space radiation environment.

Former President George Bush addressed the nation on the 20th anniversary of the

Apollo lunar landing on July 20, 1989 and had committed the nation to a human-based

journey to Mars and the Earth's Moon by the year 2019. This address prompted the

formation of a special task force which in 90 days studied and reported the feasibility, the

needs, and the alternatives for manned missions to the Moon and to Mars. Within the 90-

Day Study, the task force concluded that the realization of the President's directive was

feasible (NASA 1990). One of the most significant outcomes of the 90-Day Study had

been the identification of seven critical technologies, two of them determining the part of

the program treated in this thesis. Namely, it was recommended, among others, to actively

pursue: (1) radiation protection, which is part of the strategic goal for a Mars mission, and

(2) nuclear electric propulsion (NEP) and nuclear thermal propulsion (NTP), which will

potentially reduce a round-trip to Mars to 200 days and will enable mass savings of over

300 metric tons (MT). The trip time for chemically powered vehicles depends on the

vehicle's initial mass at low Earth's orbit (IMLEO). Chemical propulsion requires

exorbitant IMLEO for a round-trip duration comparable to that for a nuclear-powered

t A list of acronyms is presented in Appendix A.
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vehicle. Consequently, NASA had been studying a variety of mission scenarios under its

Space Exploration Initiative (SED to establish a permanent human presence on the surface

of Mars. In these studies, nuclear propulsion had played a key role in the majority of the

designs considered.

INTEGRATED ASSESSMENT OF NATURAL AND MAN-MADE

RADIATION SOURCES

Some requirements of the SEI have demonstrated the need for rapid transit times

for manned Mars missions. The main reason is to minimize the time astronauts spend in

the zero-gravity, high-background radiation environment of space. Nuclear propulsion

vehicles offer a reduced transit time as compared to conventional chemically powered

vehicles due to their higher levels of specific impulse. The planning of a nuclear-powered

manned Mars mission requires an estimate of the total crew exposure, from both man-

made and natural sources, in order to verify that this exposure would be low enough to

enable the mission. Currently, estimates of the natural space radiation dose can be

obtained from previously reported work, with some assumptions regarding the specific

mission. As the man-made contributions to the radiation dose to NEP vehicle crew

members have not as yet been thoroughly estimated, it is important to provide an

assessment of reactor dose rates inside the crew compartment.

From the aforementioned arguments it should be clear that the main motivation for

using nuclear propulsion as a means for interplanetary transportation is the reduced trip

time it offers, as compared to chemical propulsion. However, in an attempt to reduce the

total trip time without significantly increasing the initial mass in low earth orbit (IMLEO), it

is necessary to pursue nuclear reactor designs with the lowest possible specific mass. A

major component in overall power system sizing, particularly in systems involving manned

missions, is the natural and man-made radiation shields. The shields could require

significantly different design approaches. For a given reactor technology and at a specific

power output, an appropriate choice of both shield designs can indeed effect the overall

power system specific mass; this in turn can effect the total radiation dose received by the

crew. Therefore, attempts to reduce trip limes may result in a reduction of a natural

radiation source, but at the same time they may increase the man-made sources leading to

an eventual increase in crew cancer risk. On the contrary, overshielding will certainly
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reducesuch a risk, but may increase trip times as a result of increased power system

specific mass; this will in turn increase crew exposure to natural radiation.

RADIATION DOSE LIMITS

During interplanetary missions, astronauts will be confronted with nontrivial

background radiation. On Earth, the background radiation is well below any level of

concern. Occupational radiation dose limits are set to ensure the safety of radiation

workers and do not include the radiation doses from natural sources. During space travel,

however, the background radiation is much higher and it can reach lethal levels.

Consequently, dose estimates to crew members during space missions must include both

contributions from natural and man-made radiation sources.

The space radiation environment consists of several types of energetic charged

particles: electrons, protons, helium ions, and heavier particles. The relative importance of

each of these components to the radiation burden of members of a given space mission

depends strongly on many details of the mission itself. These include the spacecraft

trajectory, the time the mission occurs during the solar cycle, the orbital altitude, the

mission duration, and the available shielding within the spacecraft. Some more poorly

known physical factors am also important, such as the chance of large emissions of

particles from the sun and the broad temporal and spatial fluctuations of several of the

trapped radiation components. The National Council on Radiation Protection and

Measurements (NCRP) in its Report No. 98 recommends astronaut dose limits (NCRP

1989). The risk estimates will influence spacecraft design and mission planning in order to

comply with the NCRP dose limits from natural radiation sources.

It is an accepted fact that natural space radiation provides a more hostile

environment than that found on Earth. For this reason, space radiation dose limits for

"routine missions" and guidelines for "exploratory missions" have been recommended

(NCRP 1989) and accepted by NASA. Specific limits were set for the skin, lens of the

eye, and the hematopoietic system (Blood Forming Organs or BFO). In addition, the "As

Low As Reasonably Achievable" (ALARA) principle was adopted. Radiation doses to the

BFO are restricted because they are the most sensitive target sites for radiation-induced

carcinogenesis. Table 1.1 gives radiation dose limits for NASA's space workers as

currently recommended by the NCRP (NCRP 1989). These career limits correspond to a
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3% lifetime excess risk of fatal cancer where a career is assumed to be approximately 10

years. For the blood forming organs, the career limits range from 1 Sv for females 25

years-of-age at first exposure to 4 Sv for males 55 years-of-age at fh'st exposure. Annual

and 30-day limits are also specified so as to prevent the occurrence of nonstochastic

radiation effects such as cataracts or skin damage. An individual may receive 0.5 Sv to the

BFO in a given year of space activity, yet cannot receive more than one-half the annual

limit within any one 30-day period.

These dose limits are for total radiation exposures regardless of source. The

Occupational Safety and Health Administration (OSHA) of the U.S. Department of Labor,

the organization with regulatory authority over radiation exposures to NASA personnel,

has adopted these limits for the total exposure to all radiation sources. In addition,

however, current limits specified by OSHA limit exposures from man-made radiation

sources to only 0.05 Sv per year (OSHA 1987).

Table 1.1 Limits for protection against nonstochastic effects (30-day)

and stochastic effects (Annual and Career) in Sv. Reference (NCRP

1989).

Tune Period BFO Lens of the Eye Skin

30-day 0.25 1 1.5

Annual 0.5 2 3

Career 1.0 to 4.0 4 6

SUMMARY

The research described in this report comprises a preliminary attempt to address the

combined Radiological Health and the Nuclear Reactor Engineering aspects of NEP

vehicles, in an integrated and systematic manner. Total dose estimates resulting from both

natural and man-made radiation sources are reported for a selected vehicle configuration.
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The study of man-made radiation dose to the crew of a nuclear-powered space

vehicle is performed utilizing the MCNP radiation transport code. In addition, natural

radiation dose is incorporated using estimates previously made at the NASA Langley

Research Center. Background information on previous dose estimates for natural space

radiation, a description of the NEP vehicle, and estimates of radiation doses for man-

made sources in space missions is initially presented. Thereafter, an overview of the

methods used to assess the man-made radiation source term used in this project is

described. In particular, brief descriptions of TWODANT and ORIGEN2 codes are

presented, followed by the operating and post-shutdown fluxes of the SP-100 reactor

scaled to 25 MWth. Additionally, the computational methods used in modeling the NEP

vehicle, that is the MCNP code, are described. The results of the radiation transport

modeling of the NEP vehicle are reported, and both man-made and natural radiation

source induced crew doses are presented.

The literature review indicated the advantage of nuclear propulsion for deep space

missions, such as a Mars mission. It emphasized that space natural radiation sources

create a hostile environment. Consequently, the time spent in space should be minimized

and this can be done by shortening the travel time. There is currently no comprehensive

dose estimate for the NEP vehicle in the literature. In this work, the dose variations as a

function of two parameters, namely the tungsten and the lithium hydride layer thicknesses

of the shadow shield, were assessed.

CONCLUSIONS

The shield thickness required to reduce the reactor dose to the crew below the 0.05

Sv y-t limit is summarized in Table 1.2. The data indicate that a 30-cm thick tungsten layer

followed by a 30-cm thick lithium hydride layer would serve as an adequate shield

considering only the photon and neutron source terms from the reactor and its shield.

Photon production by neutron interactions in the shield have not been considered, yet the

LiH layer would probably have to be increased to further attenuate this photon component

of the crew dose.

Because of MCNP deep penetration limitations, the dosimetry results had to be

interpolated. The study identified that photons generated by the reactor neutrons
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interacting with the shield material were the main dosimetric concern. In general, tl.e

neutron source is the major shield design concern for the SP-100 reactor. Photons from

the reactor are easily shielded and contribute in a negligible way to the total dose as long

as the tungsten layer exceeds 15 cm in thickness.

Table 1.2 Summary of tungsten and lithium hydride thickness requirements to

lower the dose rate inside the crew compartment for the source particles below the

0.05 Sv y-I limiL

W Thickness

(cm) Neutron Component

LiH Thickness (cm)

Photon Component Total

10 52 140 140

20 40 No requirement 40

30 30 No requirement 30

REPORT OUTLINE

The previous estimates of radiation doses from natural sources, the NEP vehicle

design, and the estimates of radiation doses from man-made sources in space are reviewed

in Chapter II. Chapter HI describes the relevant tools used in the calculations of the man-

made source term. The results of the calculations with the general Monte Carlo Code for

Neutron and Photon Transport (MCNP), detailed in Chapters IV and V, give the neutron

and photon reactor flux incident upon the astronauts within the crew compartments during

full-power operation. Radiation doses to the bone marrow is estimated through the use of

fluence-to-dose equivalent conversion factors (DCF). The most recent compilation of

these factors is given in the Publication 51 of the International Commission on

Radiological Protection (ICRP) (ICRP 1987). The DCF values are given over a range of

energies and for four irradiation geometries. A brief user's guide is provided in Chapter
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VI for the Macintosh-basedcomputationaltool developedin this project.Finally, Chapter

VII providestheconclusionsandrecommendationsof thisreport.
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CHAPTER H ---

BACKGROUND INFORMATION

INTRODUCTION

This chapter presents the relevant background information regarding the nature and

design of nuclear electric propulsion (NEP) vehicles. Furthermore, some background

material is presented regarding estimates of radiation dose from natural and man-made

sources. The presentation of radiation dose estimates from natural sources includes

previous work performed at the NASA Langley Research Center.

NUCLEAR ELECTRIC PROPULSION (NEP) VEHICLE DESIGN

The Nuclear Electric Propulsion (NEP) design is one of the possible solutions for

a manned Mars mission selected by NASA. The high specific impulse provided by this

type of vehicle will enable short trip times to Mars, thus reducing crew exposures to

galactic cosmic rays and solar particle emissions. During the initial stages of vehicle design

work, careful consideration must be given to, not only the shielding requirements of

natural space radiation, but to the shielding and configuration requirements of the on-board

reactors.

The NEP technology includes an SP-100-class nuclear reactor and power

conversion subsystem coupled with electrically powered ion thrusters using argon as a

possible propellant. The reference vehicle analyzed in this report consists of a multi-

reactor NEP vehicle concept utilizing a cluster of three 5 MWe power modules (George

1992b). Each reactor is located at the end of a 120 m truss. The three reactor trusses

radiate outward in a triangular fashion from a central hub consisting of three cylindrical

crew habitation modules, the Earth Crew Capture Vehicle (ECCV), six argon propellant

tanks, and three ion thrusters. Separate calculations have been made of both the exiting

neutron and gamma-ray fluxes from the reactors during full-power beginning-of-life

operation. These data form the source terms for particle transport in the computer

simulations.
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Multi-reactorNEP systems present many advantages for space missions. The

redundancy of three 5 MWe reactors offer a greater potential reliability and their failure

modes are less catastrophic because of the partial power possibility. The modularity of

multi-reactor NEP systems allows the selection of the power level (15 MWe) to suit both

payload and mission. In the case of an accident, it is easier to repair or refurbish a smaller

reactor. The launch packages are also smaller. NEP missions will use standard reactor

and power conversion elements. This leads to reduced development and production costs.

These advantages are at the expense of the vehicle complexity and mass which are both

increased.

ESTIMATES OF RADIATION DOSE FROM NATURAL SOURCES

A major concern to interplanetary mission planners is crew exposures to highly

penetrating and damaging space radiation. Space radiation can conveniently be organized

into three main categories according to its source: (1) trapped particle radiation, (2) galactic

cosmic rays, and (3) solar particle events. The trapped particle radiation consists mostly of

electrons and protons trapped in closed orbits by the earth's magnetic field. The galactic

radiation consists mostly of protons, with a small admixture of helium ions and an even

smaller component of heavier ions. The solar particle radiation consists mostly of protons,

with a small contribution from helium ions and heavier particles. The differences between

the last two categories are mainly in the vastly different distributions of particle energies

involved and in the sporadic nature of the solar disturbances producing the solar particles

as compared with the more slowly varying nature of the galactic particle intensities (NCRP

1989).

Whenever radiation fields traverse bulk matter, the physical characteristics (fluxes,

energies, and particle types) of the propagating fields are altered through nuclear and

electromagnetic interactions with the constituent particles (nucleons and high atomic

number (Z) and energy (I-IZE) particles). These modifications include energy losses

resulting from collisions and composition changes resulting from nuclear and

electromagnetic breakup (fragmentation) processes. The net result is that radiation

environment inside equipment or the human body may differ from the environment interior

to the spacecraft. The latter, in turn, will differ from the external space environment.
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The space radiation environment consists of several types of energetic charged

particles: electrons, protons, helium, and heavier ions. The relative importance of each of

these components to the radiation burden of members of a given space mission depends

strongly on many details of the mission itself, such as the spacecraft trajectory, the time the

mission occurs during the solar cycle, the altitude, the mission duration, and the available

shielding within the spacecraft. Some more poorly known physical factors are also

important, for example, the chance of large emissions of particles from the sun and tie

broad temporal and spatial fluctuations of several of the trapped radiation components.

Their relative contributions to radiation hazards are most easily understood when

considered separately.

The trapped particles consist of both electrons and protons which are held within

the earth's magnetic field. Both particles spiral around the geomagnetic field lines,

bouncing between mirror points in the Northern and Southern hemispheres. They are

trapped in what is called the Van Allen belts. Since they are of opposite charge, the

trapped electrons drift eastward and the protons drift westward. The trapped electrons can

be found in two partially distinct regions designated the "inner zone" (< 11,500 kin) and

"the outer zone" (between 11,500 and 70,200 kin). The electron intensities in the outer

zone are approximately 10 times those in the inner zone. Both zones experience a 10-fold

diurnal variation in intensity with a smaller variation corresponding to the 11-year solar

cycle. The trapped protons occupy a more limited volume of space and are more

dosimetricaUy important than the electrons for low earth-orbiting missions such as the

space station. The most intense region of trapped protons is found between Africa and

South America where the proton belt dips to lower altitudes. This region is called the

South Atlantic Anomaly (SAA) and is caused by a slight off-center displacement of the

earth's magnetic dipole. Radiation belts are not important outside the Earth's

magnetosphere.

Galactic cosmic rays (GCR) are typically charged particles such as protons,

electrons, or other heavy, energetic particles, which are present isotropically in space and

arise from sources outside our solar system. They are the relatively constant component

of the natural radiation environment in space. Due to their interactions with the "solar

wind", their intensity decreases during the active part of the solar cycle (solar maximum).

During solar maximum, when the interplanetary magnetic field strength is greatest, cosmic

ray particles are scattered away from our solar system producing a relative minimum in the
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GCR flux. Conversely, the GCR flux is largest during minimum solar activity. The

maximum total particle flux of GCR at solar minimum is estimated to be about 4 cm-2s -1.

Their distribution within the energy range of greatest flux is 87% protons, 12% helium

ions, and 1% heavier ions (NCRP 1989). This latter group has been given the generic

term HZE (High Z and Energy). Although HZE particles are found in low abundance

with respect to protons and helium ions, they are much more densely ionizing and thus

their contribution to the total GCR dose can be substantial. Due to their high energy,

GCRs are very penetrating. Fortunately, the GCR flux is comparatively low, and thus

does not pose a serious threat to humans for short duration missions. The risk of long-

term stochastic effects such as cancer induction is, however, uncertain at present.

Radiation dose estimates for the GCR-component of the space radiation

environment have been made by researchers at NASA's Langley Research Center. Fig.

2.1 displays the GCR annual dose equivalent as a function of water shield thickness both

at solar minima and solar maxima as estimated by the Langley researchers (Townsend et

al. 1990). For all thickness considered, the dose equivalent during solar maximum is less

than half of the dose equivalent during solar minimum. Because the GCR dose is more

limiting at solar minimum, most of the studies are restricted to solar minimum periods.

This is not meant to imply that exposures during solar maximum periods are not

important. On the contrary, the cumulative exposures resulting from combined GCR and

increased solar flare activity during solar maximum could potentially be significant.

Fig. 2.2 displays the annual BFO dose equivalent as a function of various

shielding material, namely, liquid hydrogen, water, and aluminum, all at solar minima

(Townsend et al. 1990). This Fig. indicates that shielding effectiveness per unit mass

increases as the composition of the shield changes from heavier to lighter mass elements.

For liquid hydrogen, an added advantage is the reduced neutron fluence due to the

absence of neutrons in the target composition and the lack of target fragment contributions

because of the elementary nature of hydrogen.

In 1992, Townsend et al. corrected the estimates displayed on Figs. 2.1 and 2.2. Using

the Langley Research Center galactic cosmic-ray transport computer code and the

Computerized Anatomical Man (CAM) model, estimates of interplanetary exposure of

astronauts to GCR during periods of solar minimum activity were published for a realistic

human geometry shielded by various thicknesses of spacecraft aluminum shielding
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(Townsend et al. 1992). Fig. 2.3 displays the resulting BFO close equivalent as function

of aluminum shield thickness from GCR at solar minimum. The equivalent sphere

approximation yielded conservative overestimates for the actual organ exposures. This

article presented the most recent estimates of GCR shielding when the calculations

presented in this thesis were performed. The aluminum thickness of the crew
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Figure 2.1 Dose equivalent as a function of water shield thickness, resulting from

galactic cosmic rays for solar minima and solar maxima. The transport calculations

include linear energy transfer (LET) dependent quality factors from ICRP Publication 26

(ICRP 26 1977).

Reference: Townsend et al. (1990).
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Figure 2.2 BFO dose equivalent as a function of shield type and thickness, resulting

from galactic cosmic rays at solar minima. The transport calculations include linear

energy transfer (LET) dependent quality factors from ICRP Publication 26 (ICRP 26

1977).

Reference: Townsend et al. (1990).
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Figure 2.3 BFO dose equivalent from GCR as a function of aluminum shield thickness at

solar minimum. Calculations performed using the Langley Research Center GCR transport

computer code and the computerized anatomical man (CAM) model. Comparison of the

realistic human geometry (CAM model) and the 5-cm-radius tissue equivalent sphere.

Reference: Townsend et al. (1992).
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compartment was selected from Fig. 2.3 for use in this research and the conservative

value of 10 g cm "2 was used in the computer input file. This value corresponds to an

annual BFO dose equivalent of approximately 0.35 Sv as estimated with the CAM

anatomical modeL

Recently, Badhwar et al. published new GCR shielding requirement estimates

displayed in Fig 2.4 (Badhwar et al. 1993). Using the spherically symmetric diffusion

theory of the solar modulation of GCR, and data on the differential energy spectra of

hydrogen, helium, oxygen, and iron from 1965 to 1989, they showed that the GCR flux

is determined by the diffusion parameter which is a function of the time in the solar cycle.

Their analysis also showed that the fluxes in the 1954 and 1976-1977 solar minima were

similar and higher than those of 1965. They concluded that the solar cycle for cosmic-ray

intensity is approximately 22 years. Using this theory they have obtained the GCR spectra

for all nuclei and calculated the depth dose as a function of aluminum thickness. Using

ICRP Pub. 26 value for the quality factor and the 1976-1977 spectra, they showed that the

shielding required to stay below 0.5 Sv is approximately 17.5 gcm "2 of aluminum. The

calculated dose equivalent using the ICRP Pub. 60 values for quality factors is about 15%

higher than that calculated using ICRP Pub. 26 values. The new GCR shielding estimates

reported by Badhwar et al. have not been used in this study, and they are not included in

the computational tool that accompanies this report.

Solar particle events (SPE) are large emissions of charged particles from the sun

during solar flare activity. They consist mostly of protons, with a small contribution of

helium ions and HZE particles, and occur sporadically during the active phase of the

nominal 11-year solar cycle. SPEs fall into two general categories according to their

intensities: ordinary and anomalously large (AL). Due to the shielding of the earth's

magnetic field, ordinary SPEs do not contribute substantially to radiation doses in low

earth orbits. Although they occur infrequently, anomalously large SPE can contribute to

radiation doses in low earth orbits (LEO) at high inclinations.

Figs. 2.5 and 2.6 give preliminary estimates of total dose equivalent (Sv) exposures in

tissue (5-cm depth) behind various thicknesses of water and aluminum shielding for three

solar flare events (Townsend et al. 1988). For computational purpose, three major events

were selected: February 1956, November 1960, and August 1972. The 1956 event

provided the most penetrating radiations. The 1972, the largest ever
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Figure 2.4 Influence of the quality factor variations between ICRP Publication 26 and

ICRP Publication 60 on the BFO dose equivalent from GCR as a function of shielding

thickness for solar minimum. Calculations performed using the 1976-1977 GCR spectra

of Badhwar and O'Neill (1992) and the CREME model.

Reference: Badhwar et al. (1993).
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Figure 2.5 Depth-dose equivalent (Sv) in tissue (5 cm depth) as a function of water

shield thickness for three Anomalously Large Solar Particle Events. (1 g cm-2 of water is

equivalent to a thickness of 1 cm of aluminum).

Reference: Townsend, Nealy, Wilson (1988).
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shield thickness for three Anomalously Large Solar Particle Events. (1 g cm-2 of

aluminum is equivalent to a thickness of 0.37 cm of aluminum).

Reference: Townsend, Nealy, Wilson (1988).
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recordedat thattime, could have been mission-threatening for thinly shielded spacecraft

(less than 2 g cm'2). The calculations used integral particle fluences for the events as

inputs to the Langley Research Center nucleon transport code BRYNTRN. This

deterministic code transports primary and secondary nucleons (protons and neutrons)

through any number of layers of target material for arbitrary thickness and composition.

Contributions from target nucleus fragmentation and recoil are also included. Both these

figures show that SPEs are unpredictable not only on the date of the event but also on the

particle fluxes that will be emitted.

Fig. 2.7 presents estimates of the BFO dose equivalent behind various thicknesses

of aluminum shielding for the large solar proton events of August 1972 and October 1989

calculated using the coupled neutron proton space radiation transport computer code,

BRYNTRN (Townsend et al. 1991). These estimates show that both events could be life-

threatening if adequate shielding is not provided.

Fig. 2.8 displays the cumulative BFO dose equivalent as a function of water shield

thickness (Simonsen et al. 1993). The GOES-7 satellite time history data of hourly

averaged integral proton fluxes at various particle kinetic energies were analyzed for the

solar proton event that occurred between October 19 and 29, 1989. By analyzing the lime

history data, the dose rates which may vary over many orders of magnitude in the early

phases of the flare could be estimated as well as the cumulative dose as a function of time.

For deep space missions, such as a Lunar base or Mars mission, the main sources

of natural radiation are solar particle events and galactic cosmic rays. The aluminum

spacecraft thickness for the crew compartment must provide for adequate shielding from

both sources. The worst-case (at solar minimum) GCR radiation absorbed dose and dose

equivalent as a function of aluminum thickness have been estimated for various organs

(Townsend et al. 1990; Townsend et al. 1992). Aluminum is typically used in spacecraft

design. It was concluded that shielding effectiveness per unit mass increases as the

composition of the shield changes from heavier to lighter elements. For liquid hydrogen,

an added advantage is the reduced neutron fluence due to the absence of neutrons in the

target composition and the lack of target-fragment contributions because of the elementary

nature of hydrogen. For GCR shielding the materials of choice are those composed of low

atomic-mass-number constituents with significant hydrogen content.
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Figure 2.7 BFO dose equivalent as a function of aluminum shield thickness for the

August 1972 and October 1989 Solar Particle Events.

Reference: Townsend, Shinn, Wilson (1991).
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as a function of water shielding thickness. Calculations performed using the Langley

Research Center nucleon transport computer code (BRYNTRN), and the computerized

anatomical man (CAM) model.

Reference: Simonsen et al. (1993).

2-15



ESTIMATES OF RADIATION DOSE FROM MAN-MADE SOURCES

This section summarizes the results of previous studies investigating radiation

doses to the crew for exploratory class mission from on-board reactor sources. In a

NASA report from Bolch et al. (1990), scenarios involving the use of nuclear power

systems in the vicinity of the Space Station Freedom (SSF) were identified and their

radiological impact on the SSF crew was quantified. Several of the scenarios developed

related to the use of SSF as an evolutionary transport node for lunar and Mars missions.

The use of nuclear power on co-orbiting platforms and the storage and handling issues

associated with radioisotopic power systems were also explored as they related to SSF.

On one hand, the analysis methods employed to perform this task were simplified

and the results were intended to aid mission planners and identify operational and design

constraints on SSF associated with the use of nuclear power sources. The report noted

that the analysis procedure developed in this work could be extended to provide more

rigorous results.

A central philosophy in these analyses was the utilization of a dose budget

concept. The radiation source and resulting dose from the natural space environment at

SSF were fast analyzed and determined. The difference between the total dose limit

(from NCRP guidelines) and the dose from natural sources def'med the dose budget for

the SSF crew. Given the radiation source terms associated with the nuclear power system

in any given scenario, the dose budget was then employed to identify and quantify

constraints on the interaction of the system with SSF and its crew.

Both nuclear thermal rockets (NTR) and nuclear electric propulsion (NEP)

vehicles were studied. The SP-100 class reactor was assumed for the NEP missions and

most of the assumptions made were used in the present research. Nevertheless, the

approach and concern are different from the research project (SSF crew dose versus NEP

crew dose) and a comparison of the results is not appropriate.

In a conference paper, Schnitzler and Borowski (1991) summarized qualitatively

the natural and man-made radiation environment to be encountered during interplanetary

missions. Mission profiles and vehicle configurations were presented for typical all-

propulsive lunar or Mars missions. Estimates of crew-location biological doses were
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developed for all propulsive maneuvers of the nuclear thermal rocket (NTR). The

computational methods available to characterize the radiation environment produced by an

operating nuclear propulsion system are discussed. They specified that estimations of the

dose rate at the crew locations represented a classic "deep penetration" problem and was

thus poorly suited to Monte Carlo analysis. Nevertheless, they did not provide any

alternative computational method. They used pre_ous results and summarized the natural

and man-made doses in a total, budget-like dose estimate.

In a latter paper, Sager (1992) completed the calculations of Schnitzler and found

the NTR reactor dose to be 0.05 Sv for a 434-day mission (Sager 1992). No specific

description of the reactor shield or the reactor dose calculations were given.

In 1992, J. A. George presented the impact of radiation protection considerations

on vehicle design and mission performance during a manned Mars mission (George

1992a). The total interplanetary environment was considered and its radiation protection

requirements were investigated in a systems approach. The purpose of this research was

to determine the minimum integrated shielding system masses using radiation budgets.

Worst-case natural radiation doses and a 10-MWe NEP reactor dose were studied. For

the reactor, shield masses as a function of shielded dose equivalent for a five-layered

tungsten/lithium hydride shield were generated using the Lewis Research Center SHIELD

code, written by McKissock and Bloomfield in 1989 fMcKissock and Bloomfield 1989).

In that study, an 11.3" shadow shield was used to shield a dose plane slightly over 40 m

in diameter at a payload separation distance of 100 m. The shielding of the reactor is only

described as a five-layered tungsten/lithium hydride (the intent of the study was to

investigate and size a three-layered beryllium/tungsten/lithium hydride shield) and no

dimensions were specified. The study concluded that optimized shielding systems tended

to drive allowed reactor doses to 1 rem y.l. It should be noted that most of the article dealt

with natural radiation shielding.
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CHAPTER HI

MAN-MADE RADIATION SOURCE TERM

INTRODUCTION

In this chapter the space nuclear reactor SP-100, used as the basis for the Nuclear

Electric Propulsion (NEP) vehicle under consideration, is briefly described. Furthermore,

the computational tools used in the man-made radiation source term calculations are briefly

outlined, along with the results obtained from the source term calculations of the SP-100

reactor scaled-up to 25 MWth. The radiation source term of the scaled-up SP-100 reactor is

reported during steady-state operation as well as following reactor shutdown.

DESCRIPTION OF THE SP-100 SPACE NUCLEAR REACTOR

Until very recently, the SP- 100 reactor was under development as part of the U. S.

space program during the 1980s. It has a baseline thermal power of 2.4 MWth and

employs a static thermoelectric power conversion subsystem to produce 100 kWe of power.

The basic design goals of the SP-100, however, call for scalability up to an order of

magnitude higher power. For the purposes of this project, it was assumed that the reactor

would generate 25 MWth and utilize an active conversion system (Rankine cycle) in order

to provide 5 MWe of electrical power. The SP-100 is a small, compact, fast-spectrum

reactor. It utilizes highly enriched uranium mononitride fuel, niobium - 1% zirconium (Nb-

1Zr) cladding, and liquid lithium (Li) coolant. The core vessel and structure are composed

primarily of Nb-lZr and the other materials employed in the core are also refractory alloys.

Beryllium oxide (BeO) hinged reflector panels located on the outside periphery of the core

are employed as the primary control mechanism. The entire core and reflector structure is

enclosed in a conical carbon-carbon reentry shield. A layered tungsten (W), lithium-

hydride (LiH) shadow shield is employed to decrease the radiation field at the user

interface. A schematic of the SP-100 reactor is shown in Fig. 3.1.
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TWODANT: TWO-DIMENSIONAL, MULTIGROUP, DISCRETE-

ORDINATE TRANSPORT CODE

TWODANT solves the two-dimensional multigroup transport equation in plane,

cylindrical, spherical, and two-angle plane geometries. Both regular and adjoint,

inhomogenous and homogenous (k-eft and eigenvalue search) problems subject to vacuum,

reflective, periodic, white, albedo, or inhomogenous boundary flux conditions are solved.

General asymptotic scattering is allowed and anisotropic inhomogenous sources are

permitted (O'DeU et al. 1989).

TWODANT numerically solves the two-dimensional, multigroup form of the

neutral-particle, steady-state form of the Boltzmann transport equation. The discrete-

ordinates approximation is used for treating the angular variation of the particle distribution

and the diamond-difference scheme is used for phase space discretization. Negative fluxes

are eliminated by a local set-to-zero-and-correct algorithm. A standard inner (within-group)

iteration, outer (energy-group-dependent source) iteration technique is used. Both inner and

outer iterations are accelerated using the diffusion synthetic acceleration method.

The TWODANT code is part of a modular computer program package designed to

solve the time-independent, multigroup discrete ordinates form of the Boltzmann transport

equation in several different geometries. The modular construction of the package separates

the input processing, the transport equation solving, and the post processing (or edi0

functions into distinct, independently executable code modules: the Input Module, one or

more Solver Modules, and the Edit Module, respectively. The Input and Edit Modules are

general in nature and are common to any of the Solver Modules that may be provided in the

overall package. The TWODANT Solver Module contains a two-dimensional (slab,

cylinder, and sphere), time-dependent transport equation solver using the standard

diamond-differencing method for space/angle discretization. Also in existence is a Solver

Module named TWOHEX. The TWODANT Solver Module solves the time-dependent

transport equation using the diamond-differencing method for space/angle discretization in

(r,z), (x,y), and (r, q) geometries. The TWOHEX Solver Module solves the time-

independent transport equation on an equilateral triangle spatial mesh.

Some of the major features included in the TWODANT code package am:

(1) a free-field format card-image input capability designed with the user in mind;
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(2) highly sophisticated, standardized, data- and file-management techniques; both

sequential file and random-access file handling techniques are used;

(3) the use of diffusion synthetic acceleration scheme to accelerate the iterative

process in the Solve Module;

(4) direct (forward) or adjoint calculational capability;

(5) standard plane, two-angle plane, cylindrical or spherical geometry options;

(6) arbitrary anisotropic scattering order;

(7) vacuum, reflective, periodic, white, albedo, or surface source boundary

condition options;

(8) inhomogeneous (fixed) source or k-eft calculation options as well as time-

absorption, nuclide concentration, or dimensional search options;

(9) "diamond-differencing" for solution of the transport equation;

(10) user flexibility in using both card-image or sequence file input;

(11) user flexibility in controlling the execution of both modules and submodules;

and,

(12) extensive, user-oriented error diagnostics.

TWODANT INPUT OVERVIEW

The full TWODANT input consists of a tide card section, followed by six blocks of

free field inpuL The title card section is not free field. Any input referred to as a block uses

the free field input form.

Block-I consists of basic control and dimensional information that allows efficient

packing of the array data. This information also allows checking of the lengths of arrays

supplied by interface fdes.

Block-l] consists of geometric information.

Block-m consists of the nuclear data specifications.

Block-IV contains mixing information.

Block-V contains the rest of the input needed for specifying the flux calculation.
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And lastly, Block-VI contains the edit (i.e. report writing) specifications.

A cross-section library may optionally be placed between Blocks III and IV, if it is

in card image form. TWODANT supports many library formats and so the library may or

may not be in free format depending upon the option chosen.

ORIGEN2: A COMPUTER CODE FOR CALCULATING THE

NUCLIDE COMPOSITION AND CHARACTERISTICS

OF NUCLEAR MATERIALS

A wide variety of computer codes are available for calculating the nuclide

composition of nuclear reactor fuels during irradiation. Many of these codes are complex

and highly developed, involving the use of multiple-energy-group neutron spectra and cross

sections to calculate the composition of the nuclear fuel as a function of both space and

time. Nevertheless, these codes are incomplete in that they only calculate the amounts of a

limited number of nuclides known to be significant in the cases of interest (Croft 1983).

However, there is an entirely different class of problems for which these reactor

physics codes are inappropriate because they are cumbersome, expensive to use, and

provide too little detail concerning the composition of the material of interest.

ORIGEN2 is a flexible reactor physics code that provides various nuclear material

characteristics in easily comprehensible form, and in a variety of useful engineering units,

while employing a relatively unsophisticated neutronics calculation. The output is capable of

displaying great detail concerning the contribution of each individual nuclide to the overall

totals for each engineering unit. The nuclides contained in the ORIGEN2 data bases have

been divided into three segments: 130 actinides, 850 fission products, and 720 activation

products (a total of 1700 nuclides). These segments are formed by aggregating the 1300

unique nuclides (300 stable) in the data bases since some nuclides appear in more than one

segment.

The principal use of ORIGEN2 is to calculate the radionuclide composition and

other related properties of nuclear materials. The characteristics that can be computed by

ORIGEN2 include, mass, fractional isotopic composition, radioactivity, thermal power,
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radioactive and chemical ingestion toxicity, radioactive inhalation toxicity, neutron

absorption rate, neutron fission rate, spontaneous f'msion emission rate, and photon

emission. Most of these can he represented on a fractional basis so that the total

characteristic for all nuclides in a given segment is 1.O. The materials most commonly

characterized include spent reactor fuels, radioactive wastes, recovered elements, uranium

ore and mill railings, and gaseous effluent streams.

DESCRIPTION OF ORIGEN2 CALCULATIONAL METHODS

Most of the calculations carried out by ORIGEN2 are relatively trivial, involving

reading and storing data bases, converting units from g-atoms to other characteristic units,

and writing the results to output devices. There are, however, two unique features of

ORIGEN2 that require some explanation. These are: (1) the method for storing the

equations that describe the buildup and decay of nuclides, and, (2) the methods employed to

solve these equations.

In general, the rate at which the amount of nuclide changes as a function of time is

described by a nonhomogeneous first-order ordinary differential equation. Since N nuclides

are being considered, there are N equations of the same general form, one for each nuclide.

Solution (integration) of this set of simultaneous differential equations by ORIGEN2 yields

the amounts of each nuclide present at the end of each time step (integration interval).

Storage of the equation coefficients works in the following manner:

(1) Input data containing the half-lives, decay branching fractions, cross-sections,

and fission products yields for each parent nuclide are read from data bases.

(2) The daughter of each nuclear transformation, e.g. beta decay, neutron capture, is

determined, and the transformation rate and identity of the daughter are stored temporarily

in an array.

(3) The temporary array is then searched to find all of the parents of each daughter

nuclide.

(4) The transformation rate of each parent daughter nuclide and the identity of that

parent are stored sequentially in one-dimensional floating-point and integer arrays,

respectively, with the decay transformations being stored fast.

(5) Counters are maintained to indicate the array locations at which the

transformations producing each daughter nuclide begin and the number of the

transformations that are decay transformations.
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The floating-point array of transformation rates, called the transition matrix, is stored

permanently since it is invariant for a given case. The transition matrix and its

accompanying integer arrays use <20 000 decimal words of storage as compared with the

2.9 million that would be required to store the entire matrix.

After the transition matrix and its associated arrays have been established, it is

possible to begin irradiation and decay calculations. The user specifies an initial

composition of the material to be irradiated, the flux or power that it is to produce, and the

length of time step over which the flux, power, or radioactive decay is applicable. The

composition of the material at the end of the irradiation step is then calculated in three

general steps:

(1) The transition matrix parameters that are time-step dependent are set.

(2) The neutron flux is calculated from the power (or vice versa) and the transition

matrix is adjusted accordingly.

(3) The nuclide composition at the end of the time step is calculated using a

complementary set of mathematical techniques.

The final step in the calculational procedure is to solve the system of simultaneous

differential equations represented by the coefficients in the transition matrix. The method

employed by ORIGEN2 is really a composite of three solution methods, the center-piece of

which is the matrix exponential technique for solving differential equations (described

below). However, computational problems are encountered when the exponential technique

is applied to a matrix with widely separated eigenvalues, which is certainly the case for

ORIGEN2 since the coefficients in the matrix range from half-lives of seconds to billions of

years. This difficulty can be circumvented by employing asymptotic versions of the

analytical solutions to the nuclide buildup and depletion equations.

DESCRIPTION OF ORIGEN2 INPUT DATA BASES

Three principal types of input data bases are required by the ORIGEN2 computer

code: radioactive decay, photon production, and cross section. Each of these data bases is

divided into three segments. Only one or two of the segments may be required in a given

case if they include the nuclides of interest.
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The decay data baseis required for all ORIGEN2 calculations. It supplies the

following information:

(1) the list of nuclides to be considered,

(2) the decay half-lives and the decay branching fractions for beta decay to ground

and excited states, positron plus electron capture decay to ground and excited states, internal

transitions, alpha decay, spontaneous fission decay, and delayed neutron decay,

(3) the recoverable heat per decay for each radioactive parent,

(4) the isotopic composition of naturaUy occurring elements,

(5) the radionuclide maximum permissible concentration values.

The photon data base supplies the number of photons per decay in an 18-energy-

group structure. These values are used to output a table giving the number of photons and

the photon energy emission rate in 18 energy groups as a function of irradiation or decay

time. They are also used to generate a summary table listing the principal nuclide

contributors to each of the 18 energy groups. The types of photons that have been included

in the data bases are gamma rays, x rays, conversion photons, prompt and fission product

gamma rays from spontaneous fission, and bremsstrahlung. Prompt gamma rays from

f'Lssion and neutron capture are not included.

At present, three photon data bases are available, depending on the type of

bremsstrahlung (which is medium dependen0 that is included. The first and second data

bases include bremsstrahlung from a UO2 matrix and an H20 matrix, respectively; the third

includes no bremsstrahlung. A master data base containing discrete gamma-ray and x-ray

transitions and bmmsstrahlung in a 70-energy group structure is maintained at ORNL to

facilitate the generation of photon data bases in alternative energy group structures.

The function of the cross-section data bases is to supply ORIGEN2 with cross

section and fission product yields. The types of cross sections normally included are (n,g)

to ground and excited states, (n,2n) to ground and excited states, (n,3n) and (n, fission) for

the actinides, and (n,p) and (n,a) for the activation products and fission products. In

addition, a separate mechanism has been incorporated into ORIGEN2 to accommodate any

other flux-dependent reaction that is not included in this list.
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There are a large number of possible cross-section data bases for the ORIGEN2

computer code since the one-group cross-sections are highly reactor- and fuel-type specific.

The types of reactors for which cross-section libraries am now available are as follows:

(1) U and U-Pu cycle pressurized water reactors (PWRs) and boiling water reactors

(BWRs),

(2)

(3)

(4)

(5)

(6)

(7)

alternative fuel cycle PWRs,

once-through Canada deuterium uranium reactors,

O-Pu cycle LMFBRs,

thorium cycle LMFBRs,

Fast Flux Test Facility,

Clinch River Breeder Reactor.

Calculation of the one-group cross sections is a complex process that is specific to the

reactor type being considered and must be performed by sophisticated reactor physics codes

external to ORIGEN2. In general, such calculations involve generation of multiple-energy-

group cross-section data bases. These are then weighted with an approximate neutron

spectrum, resulting in a few-group cross-section data base that accounts for self-shielding

effects within the fuel rods. The few-group cross-sections for the most important nuclides

are subsequently used to perform a one- or two-dimensional depletion calculation, resulting

in (a) a prediction of the composition of the spent fuel and (b) a set of burnup-dependent

cross sections that can be incorporated into ORIGEN2 to enable it to account for

concentration and neutron spectrum changes. The composition predicted by the depletion

code is used to generate a multigroup neutron energy spectrum, which becomes the

weighting function to generate one-group cross-sections and spectrum-weighted fission

product yields for the ORIGEN2 cross-section data bases. This spectrum is also used to

generate the ORIGEN2 flux parameters which am employed to weight thermal cross

sections, resonance integrals, and threshold cross sections, respectively, when they cannot

be obtained in multigroup format.

The multigroup cross sections were obtained from ENDF/B-IV and/or ENDF/B-V,

depending on the availability of data at the time the calculations were performed. Virtually

all of the fission product yields are independent yields and were taken from ENDF/B-IV.

The exceptions am the fission yields of the very light nuclides that result from ternary

fission, which were based on a search of the literature.
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SP-100 OPERATING REACTOR FLUXES

Neutron and gamma fluxes for the beginning-of-life (BOL) of an SP-IO0 reactor

operating at 2.5 MWth were calculated by General Electric (GE) using the TWODANT

code. For the purposes of this project, the fluxes computed by GE were utilized and

appropriately scaled-up to represent a 25 MWth SP-100 reactor used in an NEP vehicle.

Furthermore, only fluxes at the bottom of the core were of interest in this project, because

the core-reflector interface comprised the man-made source term for the particle transport

calculations performed using the MCNP code. Tables 3.1 and 3.2 depict the energy ranges

for the neutron and gamma groups used in the TWODANT calculations for the 2.5 MWth

SP-100 reactor, respectively.

Table 3.1 SP-100 Neutron Energy Group Ranges.

Group Lower Energy Upper Energy

(MeV) (MeV)

I 2.23 20.00

2 1.35 2.23

3 0.82 1.35

4 0.50 0.82

5 0.30 0.50

6 0.11 0.30

7 4.09E-02 1.11E-01

8 5.53E-03 4.09E-02

9 1.67E-04 5.53E-03

10 4.14E-07 1.67 E-04

11 1.39E- 10 4.14E-07

Table 3.2 SP-100 Gamma Energy Group Ranges.

Group Lower Energy Upper Energy

(MeV) 0VXeV)
1 2.50 30.00

2 0.75 2.50

3 0.30 0.75

4 0.01 0.30
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Table 3.3 below depicts the radial distribution of the neutron fluxes at the core-

reflector interface of the 25 MWth SP-100 reactor. All 11 energy groups are listed. Figure

3.2 also depicts the radial neutron fluxes at the same axial location (core-reflector interface).

Table 3.3 25 MWth SP-100 Operating Neutron Fluxes at the Core-Reflector Interface.

Radial 0cm 4cm 8cm 12cm 16cm 20cm 24cm 28cm

Location

Energy

Group

1 2.93E+13 2.86E+13 2.65E+13 2.31E+13 1.88E+13 1.40E+13 8.99E+12 4.52E+12

2 3.41E+13 3.33E+13 3.08E+13 2.69E+13 2.19E+13 1.62E+13 1.04E+13 5.23E+12

3 4.67E+13 4.55E+13 4.22E+13 3.70E+13 3.02E+13 2.25E+13 1.46+13 7.52E+12

4 7.67E+13 7.48E+13 6.93E+13 6.05E+13 4.93E+13 3.65E+13 2.35E+13 1.18E+13

5 6.98E+13 6.80E+13 6.30E+13 5.50E+13 4.46E+13 3.29E+13 2.11E+13 1.04E+13

6 1.60E+14 1.56E+14 1.45E+14 1.26E+14 1.02E+14 7.45E+13 4.70E+13 2.26E+13

7 1.20E+14 1.17E+14 1.08E+14 9.41E+13 7.60E+13 5.56E+13 3.50E+13 1.67E+13

8 1.35E+14 1.32E+14 1.21E+14 1.05E+14 8.50E+13 6.19E+13 3.87E+13 1.82E+13

9 6.68E+13 6.50E+13 6.00E+13 5.20E+13 4.18E+13 3.03E+13 1.88E+13 8.71E+12

10 2.80E+13 2.73E+13 2.51E+13 2.18E+13 1.75E+13 1.26E+13 7.80E+12 3.58E+12

11 5.14E+12 5.00E+12 4.60E+12 3.97E+12 3.16E+12 2.26E+12 1.37E+12 5.99E+11

SP-100 POST-SHUTDOWN FLUXES

Table 3.4 depicts the gamma post-shutdown fluxes at the core-reflector interface of

the 25 MWth SP-100 reactor following operation at full power. All 18 energy groups are

listed. Figures 3.3 and 3.4 also depict the gamma post-shutdown fluxes and dose at the

same axial location (core-reflector interface).

3-11



2.00e+14

1.00e+14

0.00e+0

I i | t

-- Group 1

a Group 2

-- Group 3

s Group 4

-- Group 5

--- Group 6

,& Group 7

,& Group 8

-- Group 9

t Group 10

-- Group 11

0 10 20 30

Rlldlus (cm)
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Table 3.4 25 MWth SP-100 Post-Shutdown Gammas Fluxes at the Core-Reflector

Interface.

Tune After 1 days 5 days 10 days 20 days 30 days

Shutdown

Energy

Group

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

1.72E+17 1.04E+17 8.42E+16 6.49E+16 5.41E+16

6.38E+16 3.71E+16 2.62E+16 1.77E+16 1.39E+16

8.08E+16 4.59E+16 3.20E+16 2.07E+16 1.57E+16

3.59E+16 1.98E+16 1.54E+16 1.18E+16 9.99E+15

4.04E+16 2.63E+16 1.81E+16 1.06E+16 7.70E+15

7.54E+16 4.59E+16 3.29E+16 2.43E+16 2.00E+16

8.21E+16 2.60E+16 1.39E+16 7.69E+15 5.90E+15

4.20E+16 2.85E+16 2.02E+16 1.11E+16 6.68E+15

1.55E+17 7.13E+16 4.80E+16 3.02E+16 2.23E+16

1.63E+17 1.15E+17 9.82E+16 8.32E+16 7.45E+16

1.58E+16 3.74E+15 1.61E+15 6.10E+14 4.38E+14

4.22E+16 3.48E+16 2.69E+16 1.57E+16 9.13E+15

1.37E+15 7.94E+14 5.59E+14 3.62E+14 2.76E+14

1.54E+15 1.32E+15 1.02E+15 5.96E+14 3.47E+14

1.33E+13 1.09E+13 8.45E+12 4.95E+12 2.91E+12

1.38E+11 9.12E+00 1.55E-05 1.55E-05 1.56E-05

1.00E-06 1.00E-06 1.00E-06 1.00E-06 1.00E-06

6.34E-08 6.35E-08 6.36E-08 6.37E-08 6.39E-08
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CHAPTER IV

SPACE VEHICLE MODELING FOR RADIATION TRANSPORT

CALCULATIONS

INTRODUCTION

In this chapter the nuclear electric propulsion (NEP) space vehicle is modeled

using the neutron and photon transport code MCNP. Furthermore, the computational tool

used in this modeling, namely MCNP, is briefly outlined. The source terms used in the

space vehicle modeling include both the SP-100 reactor (man-made) and natural radiation.

MCNP: A GENERAL MONTE CARLO CODE FOR NEUTRON AND

PHOTON TRANSPORT

The Monte Carlo method is a mathematical technique for solving problems that

contain statistical processes. The method is very useful for complex problems that cannot

be modeled by computer codes using deterministic methods or when experimental

measurements may be impractical. The Monte Carlo method constructs a stochastic model

representing the process of interest. The individual probabilistic events of a process are

simulated sequentially, and the probability distributions governing these events are

statistically sampled to describe the total phenomenon. The result is an estimate of a

physical quantity characteristic of the process, specified with a measured degree of

confidence.

The Monte Carlo method was named by Von Neumann (McCracken 1955). Von

Neumann, Ulam, and Fermi applied the method towards neutron diffusion problems in the

Manhattan Project at Los Alamos during World War II. Monte Carlo techniques have

found numerous applications within the radiation sciences because of the random nature of

radioactive decay and transport processes.

In radiation transport problems, the Monte Carlo technique consists of following

each of many particles from a source throughout its life to its death in some terminal

category such as absorption or escape. Probability distributions are randomly sampled

from the transport data to determine the outcome at each step of the life of the particle.
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Random numbers are used to sample the probability, type, and outcome of interactions in

the model, thus simulating the paths of the particles in the media. After sampling

numerous values of the physical quandty of interest (e.g., particle flux, fluence, etc.), the

expected value is estimated as the average value of all histories. Associated with this

estimate is a measure of its statistical significance. Greater confidence or precision is

achieved in the average value as the number of histories sampled is increased. The

accuracy of the estimate is dependent upon the appropriateness of the stochastic model to

represent the true physical process. For radiation transport problems, the model includes

geometry and material specifications. Cross-section data for the interaction types of

interest (incoherent scattering, pair production, etc.) must be supplied for each material

present. The model also consists of algorithms used to compute the result of interactions

(changes in particle energy, direction, etc.) based on the physical principles that describe

the interaction of radiation with matter and the cross-section data provided. Therefore, it is

extremely important to model the situation well as the Monte Carlo result is only as valid as

the data supplied.

The increased speed and capabilities of computers, coupled with their widespread

availability and decreasing costs, has further simplified use of the Monte Carlo method in

solving transport problems. Much emphasis has been placed upon developing generalized

computer programs that can process a variety of transport problems. A large number of

codes currently exists for this purpose, requiring only a limited amount of user supplied

information regarding the specific problem to be examined. One of these codes is MCNP,

a general Monte Carlo code for Neutron and Photon wansport.

MCNP CODE

MCNP is a general purpose radiation transport code that is the result of 50 years of

development efforts at the Los Alamos National Laboratory (LANL) ('Bfiesmeister 1986;

Briesmeister and Hendricks 1991). The code is the union of previously independent

codes for transporting source neutrons (MCF0 (Cashwell et al. 1972), photons (MCG)

(Cashwell et al. 1973), and electrons (Integrated Tiger Series/"ITS") (Halbleib and

Mehlbom 1986), separately. The fu'st coupled neutron/photon version of MCNP was

published in 1977. Primary and secondary electron transport capabilities were included in

the most recent version released, MCNP4. Only neutron and photon sources of transport
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relevant to the work described here. Therefore, the following discussion of the MCNP

code will be restricted to neutron and photon transport.

MCNP is currently supported by the Radiation Transport Group (X-6) in the

Applied Theoretical Physics Division (X-Division) at Los Alamos National Laboratory

(LANL). The code has an extensive library of continuous-energy cross-section data.

Photon cross-section tables span the energy range I keV - 100 MeV, and were extracted

from the Evaluated Nuclear Data File (ENDF) (Kinsey 1979). MCNP features state-of-

the-art computational methods modeling the physics of interaction events. With regard to

photon transport, this includes coherent scattering, annihilation radiation emission

following absorption by pair production, and potential fluorescent emission following

photoelectric absorption. A generalized three-dimensional geometry capability is supplied

supporting first-, second-, and some specialized fourth-degree surfaces. User-supplied

geometries of a more complex nature are permitted. Numerous variance reduction

techniques are also available. Random numbers are generated using the Lehmer scheme

(Lehmer 1951). MCNP was written in pure FORTRAN 77, i.e., it contains no system

dependent features, and thus is portable to numerous machines and operating systems.

The quality of the code has been validated by countless user-years producing credible

results for a variety of applications.

Even if Monte Carlo radiation transport is not easily suited for deep penetration

problems, MCNP is currently the most reliable code on the market for neutron and photon

transport at the macrodosimetric level and it appeared to be the best solution to the current

problem. Second, the geometry set-up for one reactor could easily be modeled by MCNP

standard geometrical surfaces. Third, MCNP is portable on the Vax and UNIX systems,

the available systems on the Texas A&M University campus. These are the main reasons

why this research was performed using the MCNP transport code.

USER-SUPPLIED INFORMATION REQUIRED BY MCNP

The MCNP input file contains information about the problem in areas such as the

geometry, the materials, the source, and output tallies. The f'tle consists of three sections:

cell cards, surface cards, and data cards. The first cards, cell cards, d_be the geometry

of a problem. MCNP def'mes each region of the problem to be a "cell" bounded by

geometrical surfaces and having unique characteristics such as material composition. Each
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of the cells in a problem may be defined by the intersection and union of various types of

MCNP standard or user-defined surfaces allowed by MCNP. MCNP supplies generalized

mnemonics for describing the standard surfaces, requiring only numerical entries to

specify the scale of the problem. The sign of the numerical entry def'mes the important

concept of sense. The sense refers to the direction in which all points in a cell lie relative to

a bounding surface. By convention the interior of a cylinder or sphere is taken to be the

negative (-) direction; the exterior of a cylinder or sphere is taken to be the positive (+)

direction. A cell defined by the shorthand notation "#n" sign, contains everything that is

not in cell "n". The information presented above constitutes the "cell cards" of a MCNP

input file. Material specifications must also be defined using these cards, including the

material density and an arbitrary material reference number defined in the material card

section. Atomic densities (atom barn -1 cm -1) are denoted by a positive sign entry on the

cell card; mass densities (gcm "3) are denoted by a negative sign. The data cards include

source and tally information, the composition of the materials used in the problem, the

number of particles to be launched, variance reduction information, and options for the

output file.

INPUT FILE

A complete listing of the input fries for the four types of calculations performed

(neutron transport through the shield, photon transport through the shield, neutron

transport through the crew compartments, photon transport through the crew

compartments) is given in Appendix B. As it can be seen in Fig. 4.1, the three reactors of

the NEP vehicle design are in a same plane, and are symmetric by a rotation of 120".

Thus the calculations could be simplified and consequently the computer time could be

decreased by modeling only one of the three reactors and its shield complex. The central

structures of the vehicle, such as the crew compartment, the ion thrusters, the argon

tanks, and the Earth Crew Capture Vehicle (ECCV), are modeled separately in full detail

since particle fluxes vary with the location inside the crew compartment. As shown in

Fig. 4.2, the crew compartment is modeled as a series of six cylindrical regions with

MCNP cell designations 110, 111, 112, 113, 139, and 150 (see Appendix B). Crew

compartment 110 is directly exposed to the particle fluxes from the single reactor modeled

in the simulations and thus receives a higher dose than the other crew compartments. The

compartment numbers on Fig. 4.2 are identical to these used in the MCNP input f'rie and

in the presentation of the results in chapter IV. The other structures are modeled to take
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into account scattered particles. Due to the geometrical symmetry of the central vehicle

structures, the total particle fluxes and resulting doses when all three reactors are in

operation may be found by simple summation of the simulation results obtained for the

single reactor considered here.

The photon and neutron sources are treated separately because MCNP allows only

one kind of source particle per run. Nevertheless, during neutron source runs, photons

created by inelastic scattering and radiative capture are followed until their entire kinetic

energy is spent or until they exit the vehicle geometry and are tallied in the output f'fle.
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15 MWe
Piloted
Vehicle

Figure 4.1 Representation of a NEP vehicle.
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cell 110

cell 111

X

cell 113

cell 112

Figure 4.2 Crew compartment cell definition. The notations given in this figure are

used in Chapter IV for the presentation of the results. The Y axis is coming out of the

figure.
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Moreover,thetransportproblemis handledin two geometrysets.Thefirst setconsiders

the transportof the particlesfrom the bottom of the reactor through the entire shield

assembly.This set is run for variouscombinationsof the tungstenand lithium hydride

layer thickness.The resulting fluxes at the bottomof the shield are thencollapsedand

treatedasapoint sourcefor thesecondsetof transportcalculations.The secondgeometry

setincludesthecrewcompartment,theECCV,theargontanks,andthe ion thrusters.The

variouselementsof thegeometryincludedin this modelarenow describedin moredetail

in thefollowing paragraphs.

The first geometryset allows thetransportof sourceparticlesthrougha layer of

liquid lithium coolant and then through a multilayered shield (Fig. 4.3). The source and

the shield are surrounded by a sphere outside of which particle transport is terminated. In

MCNP terminology, the exterior of this sphere is referred to as the outside world. Liquid

lithium is used as the reactor coolant in the adopted SP-100 reactor design. The liquid

lithium layer is located between the shield and the reactor bottom; it is modeled as a

cylinder 28 cm in radius and 22.25 cm in height. The shield itself consists of various

materials layered in a cylinder 108.00 cm in radius. The designed shield is a shadow

shield, which means it shields a specific conical area of space including the crew

compartment. For computer modeling simplification, the shield is modeled as a cylinder,

whereas the design includes a conically shaped shield. The conical shape allows a

reduction of the total shield mass without a decrease in the shielding performance. The

weight factor is very important for space vehicles, but the use of a cylindrical shield

instead of a conical one should not affect the dose calculations to any significant degree.

The diameter of the cylinder was taken to be equal to the maximum diameter of the cone.

The fast layer considered in the model is the bottom-core reflector consisting of pure

beryllium (Be). Contrary to the radial Be reflectors, whose primary function is to return a

large fraction of neutrons to the core through elastic collisions, the primary purpose of the

bottom layer of Be is to scatter neutrons away from the crew compartment. Because the

distance between the reactor core and the Be layer is rather large, the reflecting property of

Be is not used to control the reactor flux. Although, not usually considered in Earth-based

reactor shield designs, this layer is included in the shadow shield design because of the

neutrons scattered into free space result in a reduction of the doses to the crew. On Earth,

radiation sources can not be simply scattered away from a specific area, radiation has to be

shielded by absorption, because of the population living near the nuclear facility area. In
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Z

Figure 4.3 NEP bottom coolant and shadow shield as modeled in MCNP. The particle

sources are distributed on the top surface of the small cylinder. The vertical lines

represent cylinders. The outside circle is a sphere def'ming the "outside world". The fast

layer of the larger cylinder represents the bottom beryllium reflector, the second represents

the tungsten gamma-ray shield, and the third represents the LiH neutron shield. The axes

correspond to the input fde for first set of geometries. The origin is at the center of the

sphere. This coordinate system is not consistent with the coordinate system adopted for

the vehicle but the MCNP source definition is simplified in this case.
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space, the astronauts are the only population. The beryllium 03e) layer is 9.34 cm thick.

The next layer is in tungsten (W) and its thickness is variable. The following layer of

natural lithium hydride (LiH) has also a variable thickness. The tungsten layer serves as

a gamma-ray shield. Materials with high atomic number (high Z) and a high density are

the shielding materials of choice in applications of gamma-ray attenuation. For tungsten,

its atomic number is 74 and its density is equal to 19.3 g cm -3. The lithium hydride layer

is a neutron shield. Optimal neutron shielding materials have a high hydrogen content or

otherwise a low atomic number (low Z). Hydrogen constitutes 50% of the atomic density

of the natural lithium hydride; the remainder constituents include 3.75% lithium-6 and

46.25% lithium-7. Lithium-6 has a high thermal neutron capture cross section.

The first geometry set origin is at the center of the disk located between the reactor

and the liquid lithium coolant. The X and Z axes are shown in Fig. 4.3, the Y axis is

directed toward the back of the figure. The second geometry set origin has the same X

and Z coordinates as the origin in Fig. 4.4 but the Y coordinate of Fig. 4.4 origin is 750.

The origin of the second geometry set is on the rotation axis of the NEP vehicle (axis Y in

the model referential system) and in the same plane as the centers of the reactors and the

argon spheres. The Y axis is directed from the ion thrusters toward the crew

compartment.

The crew compartment is modeled as a complex of six cylinders (Fig. 4.4). Three

long cylinders form a triangle and the three smaller cylinders form the vertexes of this

triangle. The vertex cylinder axes are orthogonal to the long cylinder axes. The larger

cylinders are 12 m long (outer dimension), with a 200 cm radius. Their axes are in the

(X, Z) plan of the model used for the MCNP input file. The small cylinders are 400 cm

high and 200 cm in radius. Their axes are parallel to the Y axis in the model All the

cylindrical shells are in aluminum and they have the same thickness of 3.7 cm. This

thickness was determined from the literature review on GCR shielding when the shielding

material is aluminum and corresponds to an annual dose equivalent to bone marrow of

approximately 0.35 Sv. In the model, the inside of the inner cylinders is void (zero

density).

The ECCV is located in the center of the crew compartment triangle. Figure 4.5

gives a view in the (X, Y) plane cutting the ECCV in the middle. The ECCV is

represented as an aluminum solid cone. The apex of the cone is at a height of 7.0 m (Y
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Outside world cylinder

Figure 4.4 Crew compartment. Section in plane (X, Z) at Y= 750 cm.
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axis) in the model coordinate system and its base at a height of 13.5 m. The cone axis

corresponds to the Y axis and the cone angle is 30 degrees.

The argon tanks are located below the crew compartment and their centers are in

the same (X, Z) plane as the reactors' centers (Figs. 4.5 and 4.6). The six argon tanks

are modeled as six spheres. Each sphere has an aluminum shell and is filled with liquid

argon (Fig. 4.7). Each spherical shell has a 200.32 cm outer radius and is 10.32 an

thick.

The ion thrusters are located in-between two (X, Z) planes below the origin.

These units are represented as three solid titanium rectangles 100 cm in width, 550 cm in

length, and 50 cm thick (Fig. 4.8). This model greatly simplifies the description of the

ion thrusters. In reality, the ion thrusters are a very complex assembly of electronics

components enclosed in a titanium box. Nevertheless, this simplification should not

influence the results because the ion thrusters have been incorporated in the model so that

the particles scattering from them toward the crew compartment would not be neglected.

In that case the outside material and the shape of the ion thrusters constitute the essential

structural data.

All the structures of the second geometry set are surrounded by a large cylinder

defining the "outside world". This cylinder also contains the reactor point source located

120 m away from the crew compartment ( Fig. 4.9).

The materials which have been described in this chapter are summarized in Tables

4.1 and 4.2. Table 4.1 describes the materials included in the neutron runs. Because

neutrons undergo atomic interactions, the isotopic composition of the materials needs to

be specified for neutron runs. Table 4.2 describes the materials included in the photon

runs. The tables give for each material listed: the spacecraft structure which includes the

material, the material density, and its elemental composition as described in the code. The

neutron and photon MCNP runs do not require the same material information.

The neutron source in this problem is a surface source located at the bottom of the

reactor adjacent to the lower layer of liquid lithium. The neutron fluxes am given for 11

energy groups and their values are shown in Table 4.3. The neutron energies range from

1.39 x 10-4eV to 2.23 MeV. The total neutron flux is 7.721 x 1014 neutrons cm -2 s -1.
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Figure 4.5 ECCV, crew compartment, argon tanks, ion thrusters (from top to bottom).

All the structures are inside the outside world cylnder. Section in plane (X, Y) passing

through the origin.
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Figure 4.6 Crew compartment and argon tanks inside the outside world cylinder.

Section in plane (X, Y) at Z = - 600 cm.
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Figure 4.7 Argon tanks. Section in plane (X, Z) at Y = O.
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Figure 4.8 Ion thrusters. Section in plane (X, Z) at Y = -775 cm.
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Figure 4.9 Outside world cylinder and argon tanks. Section in plane (X, Z) at Y = 0.

The source particles start in the center of disk represented by the segment on top of the

figure.
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Table 4.1 Description of the materials included in the neutron runs. The table gives for

each material listed: the spacecraft structure composed of the material, the material density,

and its elemental composition as described in the code.

Spacecraft structure Material Density (g cm-3) Isotopic Composition

Neutron Shield Natural Lithium 0.775

Hydride

Li-6 : 3.75%;

Li-7:46.25%

H-1 : 50%

Photon Shield Tungsten 19.3 Natural W

Neutron Shield

Reflector

Beryllium 1.85 B x 10-9

Coolant Liquid Lithium 0.479 Li-6:7.5%;

Li-7 : 92.5%

Crew Compartment,

Argon Tank, ECCV

Aluminum 2.7 A1-27

Ion thruster Titanium 4.5 Natural Ti

Inside Tank Liquid Argon 1.4 Natural Ar
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Table 4.2 Description of the materials included in the photon runs. The table gives for

each material listed: the spacecraft structure composed of the material, the material density,

and its elemental composition as described in the code.

Spacecraft structure Material Density (g cm-3)

Isotopic

Composition

Neutron Shield Natural Lithium 0.775

Hydride

Natural LiH

Photon Shield Tungsten 19.3 Natural W

Neutron Shield Beryllium 1.85 Natural Be

Reflector

Coolant Liquid Lithium 0.479 Natural Li

Aluminum 2.7 Natural A1Crew Compartment,

Argon Tank, ECCV

Ion thruster Titanium 4.5 Natural Ti

Inside Tank Liquid Argon 1.4 Natural Ar
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The initial sourcevaries radially following a Besselfunction distribution, but with the

distancebetweenthecrew compartmentand thereactorbeingapproximately120 m, the

transportwassimplifiedby assumingthattheneutronsourceis uniformly distributedover

thebottomsurfaceof thereactor.Thisassumptiongreatlysimplifiedthedescriptionof the

sourcetermin MCNP and thusgeneralsourcedescriptionsin the codecould beutilized.

TheMCNP generalsourcecanusesourcedistribution functions,which arespecifiedon
variouscards.

The photon sourcefor the operatingreactoris a surfacesource locatedat the

bottomof thereactorjust prior to the liquid lithium layer. Photon fluxes are uniformly

distributed on the disk area and are given in four energy groups as shown in Table 4.4.

The photon energy varies from 10 keV to 30 MeV.

The shield run results are given as surface fluxes for determined energy groups at

the bottom of the shield complex. In MCNP, these results correspond to an F2-type tally.

The particle flux is given for various energy groups. The energy groups were selected to

match the energy groups of the dose conversion factors given in ICRP Publication 51.

The energy groups for photons and neutrons are given in Table 4.5 with the

corresponding dose conversion factors.

The crew compartment run results are cell fluxes within each crew compartment.

As it has been explained in the first part of this chapter, one or more surfaces def'me a cell.

These results correspond to an F4 type MCNP tally. The flux unit is given in particles per

cm 2. With the source unit being particles per second, the results are thus expressed in

particles s-1 cm-2.

The error corresponding to the flux results for each energy group is printed in the

output f'de. The interpretation of MCNP error R is listed in Table 4.6. R is the relative

error, defined as the ratio of the estimated standard deviation of the mean to the mean

value. It represents the estimated statistical error at the ls level. An example of the tally

results and errors as presented in MCNP output files is presented in Appendix C.
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Table 4.3 Distribution of the source neutron energies and fluxes. The source neutrons

are exiting the bottom surface of a 25 MWth SP-100 class reactor operating at full power
at beginning-of-life.

Energy (MeV) Neutron Flux

(cm-2 s-l)

0.00

1.39 X 10-I0

4.14 X 10-7

1.67 X 10-4

5.53 X 10-3

4.09 X 10-2

1.11 X I0-1

3.02 X 10-1

4.98 X 10-1

8.21 X 10-1

1.35

2.23

0.000

5.136 X 1012

2.798 X 1013

6.677 X 1013

1.350 X 1014

1.202 X 1014

1.605 X 1014

6.979 X 1013

7.668 X 1013

4.665 X 1013

3.413 X 1013

2.931 X 1013
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Table 4.4 Distribution of the source photon energies and fluxes. The source photons

are exiting the bottom surface of a 25 MWth SP-100 class reactor operating at full power

at beginning-of-life.

Energy (MeV) Photon Flux

(¢m-2 s-l)

0.00 0.000

0.01 0.000

0.30 1.223 X 1013

0.75 2.165 X 1013

2.50 2.172 X 1013

30.00 8.537 X 1012
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Table 4.5 Tally energies and corresponding dose conversion factors (DCF) for neutrons

and photons.

Neutron Energy Neutron DCF Photon Energy Photon DCF

(MeV) (Sv cm 2 ) (MeV) (Sv cm 2)

0.010 0.00

0.005 3.12 X 10-12 0.015 0.00

0.025 1.05X I0-27

0.050 4.74 X 10-26

0.060 1.67X 10-25

0.252 1.67X 10-II 0.070 3.07 X 10-25

0.080 4.70 X I0-25

0.I00 1.19X 10-24

0.150 3.82 X 10-24

1.000 6.87 X I0-II 0.200 3.94 X 10-24

0.300 8.54 X lO-24

0.500 1.32 X 10-23

1.000 4.58 X I0-23

4.500 2.10 X I0-I0 3.000 1.76 X 10-22

6.000 4.21 X 10-23

I0.000 4.53 X I0-23
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Table 4.6 Interpretationof the relativeerrorR accompanyingthetally datain the output
f'tleof anyMCNP run. R representstheestimatedstatisticalerroratthe Is level.

Rangeof Error Quality of the tally

0.5 to 1 "Garbage"

0.2 to 0.5 Factor of a few

0.1 to 0.2 Questionable

< 0.1 Generally reliable
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CHAPTER V

ESTIMATES OF NEUTRON AND PHOTON DOSE RATES

INTRODUCTION

This chapter presents calculated results as dose rotes inside the crew compartment

from the tallies of the MCNP output files. MCNP fmal results are fluxes within the six

crew compartments of the NEP vehicle over a range of particle energies. These fluxes are

then multiplied by the ICRP Publication 51 dose conversion factors and summed over all

energy groups to give estimates of the total dose rate. Total close rates are expressed in

terms of annual doses to enable comparisons with the 0.05 Sv y-1 limit for man-made

sources. Fig. 5.1 gives a flow chart of the various steps followed to convert MCNP

tallies into meaningful dosimetric results.

MCNP tallies are normalized per starting particle. The simplest Monte Carlo

model for particle transport problems uses the natural probabilities with which various

events occur (for example, collision, fission, capture, etc.). Particles are followed from

event to event by the computer, and the next event is always sampled (using the random

number generator) from a number of possible events according to events probabilities.

This process is called the analog Monte Carlo model because it is directly analogous to the

naturally occurring particle transport.

The analog Monte Carlo model works weLl when a significant fraction of the

particles contributes to the estimate of interest in a manner comparable to detecting a

significant fraction of the particles in the physical situation. There are many cases for

which the fraction of particles detected is very small (less than 10-6). For these problems

analog Monte Carlo fails because few, if any, of the particles are tallied, and the statistical

uncertainty in the answer is unacceptable.

Although the analog Monte Carlo model is probably the simplest conceptual

probability model, there are other probability models for particle transport that will

estimate the same average value as the analog Monte Carlo models. They are useful

because although the average value remains unchanged, the variance (unce .r.r.r.tainty)of the
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Figure 5.1 Description of the steps in the data treatment to obtain dose rates inside the

various crew compartments of the NEP vehicle.
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estimatecan often be made much smaller than the variancefor the analog estimate.
Practically, this meansthat problemswhich would be impossibleto solve in days of

computertimecanbesolvedin minutesof computertime.

A non-analog Monte Carlo model attempts to follow "interesting" particles more

often than "uninteresting" ones. An "interesting" particle is one which contributes more

substantially to the quantity (or quantities) to be estimated. There am several non-analog

techniques, and they are all meant to increase the odds that a given particle contributes to

the final result. To ensure that the average score is the same in the non-analog run as in

the analog run, the score is modified to remove the effect of biasing the natural odds.

Thus, if a particle is artificially made X times as likely to execute a given random walk,

then the particle's score is weighted by 1/X. The average score is thus preserved because

the average score is the sum, over all random walks, of the probability of a given walk

multiplied by its resulting score.

A non-analog Monte Carlo technique will have the same expected tallies as an

analog technique if the expected weight executing any given random walk is preserved.

For example, a particle can be split into two identical pieces and the tallies of each piece

are weighted by half of what the tallies would have been without the split. Such non-

analog, or variance reduction, techniques can often decrease the relative error by sampling

naturally rare events with an unnaturally high frequency and weighting the tallies

appropriately.

In deep penetration problems such as particle transport through a thick shield, the

particle fluxes are expected to drastically decrease as the shield thickness increases. The

problem analyzed in this research is a typical example where variance reduction methods

are required. For the shield runs, the variance reduction method was indicated in the

importance cards of each cell. The importance of a cell is used for geometry splitting and

Russian roulette to help the particles move to the more important regions of the geometry,

or, if the importance is zero (such as in the "outside world"), to terminate the particle's

history.

For the crew compartment runs, the source was directed toward the crew

compartment by emitting the particles into a cone surrounding the compartment. The

results are then weighted by the ratio of the cone solid angle and the half space (2p
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steradians). By biasing the source, all particles are emitted toward the interesting region,

and the number of particles which contribute to a tally is maximized.

The results can be classified depending on the source particles and the particles

tallied. Three cases are differentiated in this thesis: (a) the neutron dose, Co) the photon

dose from reactor photon sources, and (c) the photon dose from photons created by the

neutron interactions with the shield materials. This chapter presents the variations of the

dose rate inside the crew compartment as a function of the LiH layer thickness and for W

layer thicknesses: 10, 20, and 30 cm. Under the assumption that all three reactors of the

NEP vehicle are operating simultaneously, the annual dose limit per reactor would be

(0.05/3 Sv) or 0.0166 Sv per year per reactor. This value is indicated as a horizontal line

on each figure. Each graph gives five additional curves showing variations in dose rate

with location inside the six crew compartments. For this vehicle design it is obvious that

the higher dose rates occur inside the smaller cylinder positioned closest to the reactor in

question.

NEUTRON RESULTS

Figures 5.2 through 5.4 show the calculated values of the variations of the neutron

dose rates inside the crew compartment for the three W layers previously mentioned, each

as a function of the LiH thickness. From Fig. 5.2, the minimum LiH thickness required

to lower the neutron dose below 0.0166 Sv y-1 is 50 cm, if the W layer is 10 cm thick.

The 50 cm of LiH will only lower that component of the dose rate which is due to the

neutron source term. It should be kept in mind that there is always a photon source term

and that the final design will have to consider the total dose rate from both contributions.

The lower-weight solid line (cell union) indicates the crew dose rate per operating reactor

averaged over all six crew compartments. Error bars are not plotted on any of the graphs

as they are too small to be visible relative to the graph scales. The calculational percent

errors on the dose rates were on the order of maximum 5% for all cases simulated.

Fig. 5.3 shows the neutron dose rate variations inside the crew comparunents for

a 20-cm thick W layer as a function of the LiH layer thickness. This plot defines an

approximately 40 cm minimal thickness necessary to lower the neutron dose below the

0.0166 Sv y-1 limit when the tungsten layer is 20 cm thick. This minimal LiH thickness
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Figure 5.2 Neutron dose rates inside the six crew compartments due to the neutron

source of one SP-100 reactor with a 10-cm thick tungsten layer and a variable lithium

hydride thickness.
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Figure 5.3 Neutron dose rates inside the six crew compartments due to the neutron

source of one SP-100 reactor with a 20-cm thick tungsten layer and a variable lithium

hydride thickness.
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Figure 5.4 Neutron dose rates inside the six crew compartments due to the neutron

source of one SP-100 reactor with a 30-cm thick tungsten layer and a variable lithium

hydride thickness.
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is lower than the 50 cm LiH necessary in the case of a 10-cm W shield. It is interesting to

note that, even if the tungsten is included in the design as a photon shield, the neutrons

interact with the tungsten. The neutrons undergo elastic scattering within the tungsten,

over their energy range. Moreover, thermalized neutrons undergo (n, g) reactions in

tungsten, while fast neutrons undergo inelastic scattering.

Fig. 5.4 shows the neutron dose rate variations inside the crew compartment for a

30-cm thick W layer as a function of the LiH layer thickness. This plot defines a 30 cm

minimal thickness to lower the neutron dose below the annual limit when the tungsten

layer is 30 cm. Once again, this minimal LiH thickness is lower than the 50 cm of LiH

necessary in the case of a 10-cm W shield. The neutron dose rate decreases exponentially

with increasing LiH thickness. In addition, it decreases with increasing W thickness.

The shield design can not be determined from the neutron dose rates exclusively; the

photon dose rates have to be taken into account in the overall dose estimates.

PHOTON RESULTS

Figures 5.5 through 5.7 show the calculated values of variations of photon source

term dose rates inside the various crew compartments for the three W layers previously

mentioned, as a function of the LiH thickness. In Fig. 5.5, the minimum LiH thickness

for a 10-cm W layer is greater than 50 cm. The results for the maximum LiH layer

computed are above the limit, but to estimate the minimal thickness of LiH, the curves are

extrapolated by a curve fit procedure. In Appendix D, the curve fit data are plotted. The

minimal LiH thickness is found by extrapolation to be 150 cm. The photon dose rates

dec_ very slowly with increasing LiH thickness, compared to the corresponding

neutron attenuation through the shield.

Fig. 5.6 shows the reactor photon dose rate variations inside the crew

compartments for a 20-cm thick W layer as a function of the LiH layer thickness. For any

LiH thickness the photon dose is below the 0.0166 Sv y-1 limit. The dose rates are lower

by a factor of 1000 compared to the values for a 10-cm thick W layer. The variations in

the photon dose rates are much more sensitive to the W layer thickness than to the LiH

layer thickness.
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Figure 5.5 Photon dose rates inside the six crew compartments due to the photon

source of one SP-IO0 reactor with a lO-cm thick tungsten layer and a variable lithium

hydride thickness.
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Figure 5.6 Photon dose rates inside the six crew compartments due to the photon

source of one SP-100 reactor with a 20-cm thick tungsten layer and a variable lithium

hydride thickness.
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Fig. 5.7 shows the reactor photon dose rate variations inside the crew

compartment for a 30-cm thick W layer as a function of the LiH layer thickness. There is

no necessary minimal LiH thickness since the photon dose is always below the 0.0166 Sv

y-1 limit when the tungsten layer is 30-cm thick.

These figures show the dose rates inside the crew compartment due to the photons

exiting the reactor. However, neutron interactions within the shield materials generate

additional photons through inelastic collisions and radiative capture reactions and thus

need to be considered in a total shielding assessment.

Figures 5.8 through 5.10 show the calculated values of the variations of the

neutron-generated photon dose rates inside the crew compartments for the three W layers

previously mentioned, as a function of the LiH thickness. The computer run results are

above the limit for the three figures and thus, to estimate the minimal thickness of LiH, a

curve fitting procedure is employed. The curve fit graphs are presented in Appendix D. In

Fig. 5.8, the minimum LiH thickness for a 10-cm W layer exceeds 120 cm. The dose rates

inside the crew compartment for a 120-cm thick LiH layer are in the order of 12 to 100 Sv
-1

y depending on the crew compartment location, which is about 10,000 times the yearly

limit. For a number of reasons, these results are considered questionable and are believed

to greatly overestimate this component of crew dose.

The overestimate of photon generation by neutron interactions is mostly due to the

neutron cross sections which were available at the time this transport calculations were

performed. These cross sections are not the most recent as they were published in the

early 1980's. The photon production data contained in older MCNP libraries are referred

to as "30 x 20 photon production" data in the MCNP manual. There is no information

concerning individual photon production reactions in the 30 x 20 data. The only

secondary photon data are a 30 x 20 matrix of photon energies; this means that for each of

30 incident neutron energy groups there are 20 equally probable exiting photon energies.

In more recent MCNP libraries, compiled by Fisher in 1989 (Fisher 1989), the secondary

photon energy distributions are a function of incident neutron energy. These revised

cross sectional libraries were not implemented into MCNP until recently and thus were not

available for use in the current modeling effort. In addition, the cross sections used in this

work contain no information regarding secondary photon angular distributions; therefore,

all photons are taken to be produced isotropicaUy in the laboratory system.
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Figure 5.9 Photon dose rates inside the six crew compartments due to one SP-100

reactor neutron interactions through the shield with a 20-cm thick tungsten layer and a

variable lithium hydride thickness.

5-14



102

Limit for a reactor - - • - Cell 112 W30

----0 Cell 110 W30 - - O- Cell 139&150 W30

- - X- Cell lll&l13 w30 -- Cell Union W30

w,m

°_._

O'2

0
£3

10 t

I0°

10 -1

10-2

• "'- ..

"A

' ' ' I ' ' ' I ' ' ' I ' ' ' I

20 40 60 80 I00

Lil-IThickness (cm)

| ! !

120
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Thereareseveralproblemsassociatedwith 30x 20photonproductiondata. The 30 x 20

matrix is an inadequaterepresentationof the actualspectrumof photonsproduced. In

particular,discretephotonlines arenot well represented,and the high-energytail of a

photon continuum energy distribution is not well sampled. Also, the multigroup

representation is not consistent with the continuous energy nature of MCNP. Finally, not

all photons should be produced isotropicaUy.

Fig. 5.9 shows the neutron-generated photon dose rate variations, inside the crew

compartment, for a 20-cm thick W layer, as a function of the LiH layer thickness, where

these photons are generated by the neutron interactions inside the shield. The dose rates

inside the crew compartments for a 110-cm thick LiH layer are in the order of 3 to 20 Sv

y-I depending on the compartment, which is still about 1000 times the yearly limit. The

dose rates are lower by a factor of 10 compared to the values for a 10-cm thick W layer.

The variations in the photon dose rates am more sensitive to the W layer thickness than to

the LiH layer thickness.

Fig. 5.10 shows the neutron-generated photon dose rate variations, inside the

crew compartment, for a 30-cm thick W layer, as a function of the LiH layer thickness;

the photons am generated by the neutron interactions inside the shield. The dose rates

inside the crew compartment for a 100 cm thick LiH layer am in the order of 0.7 to 4 Sv

per year depending on the location inside the compartment, which is still about 100 times

the yearly limit.

The photons am created in many different ways: (n, g) radiative capture reactions,

de-excitation of the atom following an inelastic scattering, etc. An analysis of the various

possibilities of gamma production from the neutron reactions is performed by looking at

the neutron cross sections (Fisher 1989) of the various materials layered in the shield.

Neutrons exiting the reactor bottom first traverse a liquid lithium layer (22-cm in

thickness) where, with their energy range they can either have an (n, 0 or an elastic

scattering with 6Li, or they can have an elastic or an inelastic scattering with 7Li. The

cross section for 7Li gamma production increases to 0.20 barns in this energy region.

Lithium-6 gamma production cross section is on the order of 10 -5 barns. Neutrons next

traverse a layer of beryllium 10 cm in thickness. Elastic scattering accounts for essentially

100% of the total interactions in this layer and thus there is no production of gamma-rays.

Neutrons which pass through these layers have been slowed down. Most of the gamma-
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ray production by neutron reactions inside the shield thus occurs in the tungsten layer.

The gamma production cross section of tungsten is approximately 10 4 barns, and displays

a broad a resonance peak for neutron energies between 10 .6 and 10. 2 MeV. The neutrons

modeled in this work have energies into this resonance region and approximately 78% of

the reactions are (n, g) reactions while approximately 22% are elastic scattering events.

There is some gamma-ray production in the lithium hydride layer, but it is minor

compared to that in the tungsten. Lithium hydride is not a good photon shield, so their

fluxes are not substantially attenuated when they exit the shield. Nevertheless, because of

MCNP cross sections deficiencies, these photon dose rates are overestimated and should

not be considered in the design of the shield. Additional calculations should be performed

with the more recent neutron cross sections to obtain more accurate estimates of the

photons created by neutron interactions within the shield. Figures 5.8 to 5.10 show that

there are photon creations inside the shield and that these photons should be considered in

the dose estimates of a mission. For the reasons given above, these figures have only a

qualitative rather than quanttafive value.

TOTAL DOSE RATE RESULTS

Figures 5.11 to 5.13 show variations in total dose rate from the reactor sources of

photons and neutrons of one SP-100 reactor, within each of the crew compartments, for

the three W layers previously mentioned, and as a function of the LiH thickness. From

Fig. 5.1 I, the minimum LiH thickness required to lower the total dose below 0.0166 Sv

y-l, varies from 60 cm to 150cm if the W layer is 10 cm in thickness. The variations

depend on the location of the crew compartrnenL These data have been extrapolated from

the curve fits on the photon and neutron dose rates. The curve fits are calculated from the

plots of the logarithm of the dose rates. The logarithm of the dose rates are fitted with

quadratic equations, then the dose rates are calculated by taking the exponential of the

curve fit values. With I0 cm of tungsten, the photon dose rate inside each crew

compartment is more important than the neutron dose if the LiH layer is more than 45 on

thick.

Fig. 5.12 shows the total dose rate variations inside the crew comparmaents for a

20-em thick W layer as a function of the LiH layer thickness. This plot defines a 40 on

minimal thickness to lower the neutron dose below the 0.0166 Sv y-I limit when the
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Figure 5.11 Total dose rates inside the crew compartment from the neutrons and

photons created from one SP-100 reactor with a 10-cm thick tungsten layer and a variable

lithium hydride thickness.
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Figure 5.13 Total dose rates inside the crew compartment from the neutrons and

photons created from one SP-100 reactor with a 30-cm thick tungsten layer and a variable

lithium hydride thickness.
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tungsten layer is 20-cm thick. This minimal LiH thickness is lower than the 60 era of LiH

necessary in the case of a 10-cm W shield. With a tungsten thickness of 20 cm, the

photon dose rate inside the crew compartment is more important than the neutron dose if

the LiH layer is more than 65 cm in thickness.

Fig. 5.13 shows the total dose rote variations inside the crew compartment for a

30-cm thick W layer as a function of the LiH layer thickness. This plot defines a 30-cm

minimal thickness to lower the neutron dose below the 0.0166 Sv y'_ limit when the W

layer is 30-cm in thickness. Once again, this minimal LiH thickness is lower than the 50

cm of Lil-I necessary in the case of a 10-era W shield. With this W thickness, the neutron _

dose appears to be more of a concern than the photon dose from the reactor. There is no

perfect shield design, but it seems that a minimum of 20 cm for the W layer can be

recommended. With increasing W thickness, the minimal LiH thickness necessary to

lower the dose rate below the annual limit decreases. Most of the photons generated by

neutron interactions inside the shield are created in the W thickness. It should be noted that

photon dose rates resulting from neutron interactions in the shield materials were not

included in the total dose rate graphs. This neutron generated gamma dose rate could be

comparable to the neutron dose itself. Therefore, additional transport calculations should

be performed to account for this component of the total dose rate.

Figures 5.14 to 5.16 show the total dose rate variations inside the most exposed

cell of the crew compartment, for 10-cm, 20-cm, and 30-cm thick tungsten layers,

respectively, and as a function of the LiH layer thickness. These plots contain the neutron

dose rates, the photon dose rates, and the total dose rates due to one reactor. The graphs

explain the shape of the total dose rate curve by showing whether the neutron or photon

dose rates are dominant.

Fig. 5.17 gives the three-reactor total dose rates inside the most exposed cell of the

crew compartment, for 10-cm, 20-cm, and 30-cm thick tungsten layers. The three-reactor

data are calculated by simply multiplying the dose rate within the most exposed crew

compartment by a factor of three. This graph gives the estimates of total crew dose rates

due to the neutrons and photons generated by three 5 MWe SP-100-class reactors during

beginning-of-life, full-power operation.
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CHAPTER VI

MacSpace rM USER'S GUIDE

INTRODUCTION

This chapter describes the skeletal version of the MacSpace r_ software that

embodies the computational results developed in this study. The chapter begins with a

brief description of the computer system requirements for proper operation of

MacSpace ru. In the remainder of the chapter a summary menu reference is provided along

with a brief description of a sample run.

COMPUTER SYSTEM REQUIREMENTS

MacSpace _ has been developed to operate with Macintosh computers.

MacSpace rM requires System 7.0 or later, and MS Excel 5.0 or later installed. As a result

of the need to install MS Excel 5.0 or later, at least 4 MB of RAM and approximately 10

to 20 MB of free hard disk space is required. A math co-processor (FPU) is required for

proper execution and for speeding-up the numerical computations.

MacSpace rM MENU REFERENCE

MacSpace m is developed to execute with Excel. Therefore, the main menu bar

includes all of the standard MS Excel menus, as well as a MacSpace _ menu. The main

menu bar menus allow the user to enter and manipulate all data necessary to work with

MacSpace rM.

The main menu bar includes the following menus:

• File

• Edit

• View

• Insert

• Format

• Tools
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• Data

• Window

• MacSpace TM

Now, these menus and the menu items they contain are briefly described. Detailed

information is presented only for the MacSpace TM menu, whereas the other standard

Excel menus are only mentioned. Additional information regarding these standard Excel

menus can be found in the Excel User's Guide.

The File Menu

The File menu is for manipulating Excel files, i.e. workbooks that contain

worksheets or other types of files. This menu contains, among others, menu items used

for opening a new or an existing file, for closing a file, for saving a file, for reverting a

file to a saved version: for printing a file, and for quitting Excel.

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu items are available in the File menu:

• New

• Open...

• Close

• Save

• Save As...

• Save Workspace...

• Find File...

• Summary Info...

• Page Setup...

• Print Preview

• Print...

• Print Report...

• Recently Opened Documents

• Quit
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The Edit Menu

The Edit menu is for manipulating the Excel file contents. The main Excel fde unit

is a workbook, and it contains a number of worksheets. Each worksheet in the workbook

contains cells in the form of rows and columns. This menu contains, among others, menu

items used for cutting and pasting data and for publishing and subscribing to other files.

The command key equivalents of the menu items axe shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu and sub-menu items are available in the Edit menu:

• Undo

• Repeat

• Cut

• Copy

• Paste

• Paste

• Fill

• Clear

Special...

Down

Right

Up

Left

Across Worksheets...

Series...

Justify

• All

• Formats

• Contents

• Notes

• Delete...

• Delete Sheet

• Move or Copy Sheet...
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• Find...

• Replace...

• Go To...

• Publishing

• Create Publisher...

• Subscribe To...

• Links...

• Objects

The View Menu

The View menu is for manipulating the various toolbars available and for

determining the way the workbook windows are viewed. This menu contains, among

others, menu items used for full-screen viewing and for zooming the Excel workbook

windows.

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu items are available in the View menu:

• Formula Bar

• Status Bar

• Toolbars...

• Full Screen

• Zoom...

• View Manager...

The Insert Menu

The Insert menu is for adding the various objects available in Excel, such as

cells, rows, columns, worksheets, charts, etc.. This menu contains, among others, menu

items used for adding and defining new macros.
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Thecommandkeyequivalentsof themenu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu and sub-menu items are available in the Insert menu:

• Cells...

• Rows

• Columns

• Worksheet

• Chart

• On This Sheet

• As New Sheet

• Macro

• Module

• Dialog

• MS Excel 4.0 Macro

• Page Break

• Function...

• Name

• Define...

• Paste...

• Create...

• Apply...

• Note...

• Object...

The Format Menu

The Format menu is for formatting the various objects available in Excel. This

menu contains, among others, menu items used for changing the look and feel of the

ceils, worksheets, etc..

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.
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The following menu and sub-menu items axe available in the Format menu:

• Cells...

• Row

• Height...

• AutoFit

• Hide

• Unhide

• Column

• Width...

• AutoFit Selection

• Hide

• Unhide

• Standard Width...

• Sheet

• Rename...

• Hide...

• Unhide...

• AutoFormat...

• Style...

• Placement

• Bring to Front

• Send to Back

• Group

The Tools Menu

The Tools menu provides the various functions for expediting work with Excel.

This menu contains, among others, menu items used for spell checking, recording

macros, creating add-ins, etc..

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.
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Thefollowing menuandsub-menuitemsareavailablein theToolsmenu:

• Spelling

• Auditing

• Trace Precedents

• Trace Dependents

• Trace Errors

• Remove All Arrows

• Show Auditing Toolbar

• Goal Seek...

• Scenarios...

• Solver...

• Protection

• Protect Sheet

• Protect Workbook

• Add-Ins...

• Macro...

• Record Macro

• Record New Macro...

• Use Relative References

• Mark Position for Recording

• Record At Mark

• Assign Macro...

• Options...

The Data Menu

The Data menu is for manipulating and handling the data available on the

worksheets. This menu contains, among others, menu items used for grouping and

ungrouping data, consolidating data, etc..

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu and sub-menu items are available in the Data menu:
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• Sort...

• Filter

• Auto Filter

• Show All

• Advanced Filter...

• Form...

• Subtotals...

• Table...

• Text to Columns...

• Consolidate...

• Group and Outline

• Hide Detail

• Show Detail

• Group...

• Ungroup...

• Auto Outline

• Clear Outline

• Settings...

• PivotTable...

• PivotTable Field...

• Refresh Data

• Get External Data...

The Window Menu

The Window menu is for determining which window within the Excel

application will be visible. This menu contains, among others, menu items used for hiding

and unhiding windows, splitting windows, and switching among open windows.

The command key equivalents of the menu items are shown adjacent to the menu

item. The command key equivalents allow that menu item to be selected from the

keyboard.

The following menu items are available in the Window menu:

• New Window
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• Arrange...

• Hide

• Unhide...

• Split

• Freeze Panes

• Show Clipboard

• Open Windows

The MacSpace _ Menu

The MaeSpaee rM menu contains menu items specific to the application

developed. This menu contains, among others, menu items used for selecting a mission,

setting the various items for space vehicle configuration, and calculating the crew doses

and crew radiation risk.

The following menu and sub-menu items are available in the MacSpace _ menu:

• About MaeSpaeerM...

This menu item reveals the start-up dialog documenting the support provided for

the development of MaeSpaee m. By clicking on the Credits button, additional

information can be obtained regarding the developers of the software.

• Help...

This menu item contains the on-line help to be made available in a future version

of MaeSpaee rM. Currently, this menu item is visible, though no on-line help can be

obtained.

• Mission

This menu item contains the missions considered in MaeSpaee m. Even though

four mission options are currently provided, only the Mars mission option is operational.

The following sub-menu items are included in the Mission menu:

• Mars

This sub-menu item contains the options available to choose from in

performing a Mars mission. Execution of this sub-menu item results in the display of a

dialog box which allows the user to choose one of the following options: (1) Nuclear

Electric Propulsion (NEP), (2) Nuclear Thermal Rocket (NTR), or, (3) Non-Nuclear.

Currently, only the NEP option to the Mars mission is operational.

• Lunar
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This sub-menu item contains the options available to choose from in

performing a Lunar mission. Execution of this sub-menu item currently results in a

warning message, as there are no options for a lunar mission yet.

• Asteroid

This sub-menu item contains the options available to choose from in

performing an Asteroid mission. Execution of this sub-menu item currently results in a

warning message, as there are no options for an Asteroid mission yet.

• Alternate

This sub-menu item contains the options available to choose from in

performing any Alternate mission. Execution of this sub-menu item currently results in a

warning message, as there are no options for any Alternate missions yet.

• Config Vehicle

This menu item contains the vehicle components that can be altered for specific

missions considered in MacSpace TM. Even though four component options are

currently provided, only the "Reactors" component can be altered. The following sub-

menu items are included in the Config Vehicle menu:

• Reactors...

This sub-menu allows the user to select the various reactor options which

impact the crew dose and risk calculations. Currently, the options available for change are

the thickness of the tungsten shield and the thickness of the lithium-hydride shield in the

reactor.

• Tanks...

This sub-menu allows the user to select the various propellant tank options

which impact the crew dose and risk calculations. These options are only meaningful for

an NTR-type mission. As NTR mission scenarios are not currently operational, the

various propellant tank options cannot be set yet.

• Habitat...

This sub-menu allows the user to select the various crew habitat options

which impact the crew dose and risk calculations. In future versions of the software, the

option available for change will be the thickness of the aluminum shield in the crew habitat

which protects against natural radiation.

• Other...

This sub-menu allows the user to select the various options present in

other space vehicle components which impact the crew dose and risk calculations.

Currently, no other space vehicle component can be changed.
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• Options...

Thismenuitemcontainsthe variousoptionsthat can be set for specific missions

considered in MaeSpaee ha. Currently, only natural radiation options are available. The

following natural radiation options are available for selection:

(1) Solar Maximum, or,

(2) Solar Minimum, for Galactic Cosmic Radiation (GCR) fluxes,

and,

(1) February 1956,

(2) November 1960,

(3) August 1972,

(4) August 1989,

(5) September 1989, and,

(6) October 1989, for Solar Particle Events (SPE) spectra.

• Calculate

This is the main menu item in MaeSpaee rM which is used for the various

calculations. The following sub-menu items are available in this menu:

• Crew Dose...

This calculation involves the determination of the crew dose by mission

phase and the total dose for the selected mission and for the configured spacecraft.

• Radiation Risk...

This calculation involves the determination of the crew radiation risk by

mission phase for the selected mission and for the configured spacecraft. The crew dose

calculation must be performed fast.

A SAMPLE RUN

In this section a sample step-by-step session of MacSpace rM is briefly described

along with the entered input and the expected results. In order to perform a MacSpace rM

run, the following step should be followed:

(1) Make sure that your Macintosh has an FPU and it is running under System 7.0 or

later,

(2) Make sure that Excel 5.0 or later is installed in your system,

(3) Insert the diskette and copy the f'de named "MacSpace rM v 1.0" anywhere into your

harddisk,
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(4) Double-click on the icon of the file named "MacSpace TM vl.0"; this should start

execution of the program,

(5) A start-up dialog will appear; either click the "Credits" button for more information

or click the "OK" button to dismiss the start-up dialog box,

(6) Following dismissal of the start-up dialog box, you should be viewing either an

empty worksheet or a worksheet filled with calculations from prior runs; you can

either delete these prior runs, overwrite the existing numbers or create a new

work-sheet,

(7) From the menu "MacSpace ru'' select the menu item "Mission"; you should be able

to view a sub-menu with four sub-menu items,

(8) Select the "Mars" sub-menu item from the "Mission" menu; a Mars mission is the

only scenario currently available,

(9) Selection of the "Mars" sub-menu should reveal a dialog box with three available

options; select the "NEP" button and click the "OK" button; an NEP Mars mission

is the only scenarios currently available in MacSpace TM,

(10) You should be viewing the various inputs to an NEP Mars mission scenario, with

default values available for each mission phase duration and power level

requirements; you will be able to alter mission phase duration, though power level

requirements cannot be altered in this version of MacSpaee TM,

(11) Make any changes to the mission duration and click the "OK" button,

(12) From the menu ''MacSpace ru'' select the menu item "Config Vehicle"; you should

be able to view a sub-menu with four sub-menu items,

(13) Select the "Reactors" sub-menu item from the "Contig Vehicle" menu,

(14) You should be viewing a dialog box which allows you to set the various reactor

options; you will be able to alter the tungsten shield thickness (not the material

itself), and the lithium-hydride shield thickness (again, not the material itself),

(15) Make any changes to the reactor options and click the "OK" button,

(16) From the menu "MacSpace ru'' and menu item "Config Vehicle", select the sub-

menu item "Habitat",

(17) You should be viewing a dialog box which allows you to set the various crew

habitat options; you will not be able to alter any of the habitat settings at this point,

click the "OK" button,

(18) From the menu "MacSpace ru'' and select the menu item "Options...",

(19) You should be viewing a dialog box which allows you to set the various natural

radiation options, such as the GCR flux levels and the solar flare spectra; you can
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only selectthesolarminimumflux levelandamongthreesolar flare spectra;mal_e
yourselectionsandclick the"OK" button,

(20)From themenu"MacSpacerw' and menu item "Calculate",selectthe sub-menu
item "Crew Dose...",,

(21)You should be viewing a dialog box which allows you to check the various

radiationdosesourcesfor the calculations;makeyour selectionsand click the
"OK" button, this should initiate the calculationswith the results written on

"Sheetl" of theopenworkbook,

(22)From themenu"MacSpacerw' and menuitem "Calculate",selectthe sub-menu

item "RadiationRisk...",

(23)You shouldbeviewing a dialog box which allowsyou to setthe risk factorsfor

thevariousradiationdosesourcesinvolved in thecalculations;set therisk factors
and click the "OK" button, this should initiate the calculationswith the results

written, again,on "Sheetl" of theopenworkbook.

For thedefaultsettingsin MacSpacerM,youshouldobtainthefollowing results:

Mission Phase

Mars NEP Mission

Dose Calculations

Duration (days) Cumulative Power (MWth)

Duration (days)

Earth Spiral-Out 443.0 443.0 75.0
(from 450 km)

Heliocentric to Mars

1st Portion: Thrust 253.0 696.0 75.0

2nd Portion: Coast 162.0 858.0 0.6

3rd Portion: Thrust 85.0 943.0 75.0

Mars Spiral-In 86.0 1,029.0 75.0

Mars Operations 150.0 1,179.0 1.2

Mars Spiral-Out 39.0 1,218.0 75.0
Heliocentric to Earth

1st Portion: Thrust 74.0 1,292.0 75.0

2nd Portion: Coast 211.0 1,503.0 0.6

3rd Portion: Thrust 68.0 1,571.0 75.0

Earth Spiral-In 239.0 1,810.0 75.0
(to 450 km)

Earth Orbit Arrival Variable Variable Shutdown

Total NEP

Mission Parameters 1,810.0
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GCR Dose

(Sv)
SPE Dose (Sv) Neutron Dose (Sv) Photon Dose (Sv)

O.00E+00 0.00E +00 0.00E+O0 O.00E+O0

3.17E-01 3.45E-01 3.40E-02 1.25E-04

2.03E-01 0.00E4-00 2.17E-02 8.02E-05

1.06E-01 0.00E+00 1.14E-02 4.21E-05

1.08E-01 0.00E+O0 1.15E-02 4.26E-05

1.88 E-01 0.00E+O0 2.01E-02 7.43E-05

4.88E-02 0.00E+00 5.23E-03 1.93E-05

9.27E-02 0.00E+00 9.93E-03 3.67E-05
2.64E-01 0.00E+00 2.83E-02 1.05E-04

8.51E-02 0.00E+00 9.13E-03 3.37E-05

0.00E+00 0.00E+00 0.OOE+O0 0.00E+00

0.00E+00 0.00E+00 0.00E+00 0.00E+00

1.4 0.3 0.2 0.0

Total Mission GCR SPE Risk Neutron Risk Photon Risk

Risk (% (% (% Increase (% Increase
Increase Increase in Lifetime) in Lifetime)

in in

Lifetime) Lifetime)

Phase Dose (Sv)

O.OOE+O0 0.0 0.0 0.0 0.0

6.96E-01 0.6 0.5 0.0 0.0

2.25E-01 0.4 0.0 0.0 0.0

1.18E-01 0.2 0.0 0.0 0.0
1.19E-01 0.2 0.0 0.0 0.0

2.08E-01 0.4 0.0 0.0 0.0

5.41E-02 0.1 0.0 0.0 0.0
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1.03E-01 0.2 0.0 0.0
2.93E-01 0.5 0.0 0.0
9.43E-02 0.2 0.0 0.0
0.00E+00 0.0 0.0 0.0

O.OOE+O0 0.0 0.0 0.0

0.0

0.0

0.0

0.0

0.0

1.9 2.8 0.5 0.2 0.0

Key Reactor Parameters

Man-made Radiation Shields

Gamma Shield

Material

Thickness (m)
Neutron Shield

Material

Thickness (m)

Key Habitat Parameters

Natural Radiation Shield

Material

Thickness (gm/cm^2)

Tungsten
0.2

Lithium Hydride
0.4

Aluminum

10.0
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CHAPTER VH --

CONCLUSIONS AND RECOMMENDATIONS

SUMMARY

The study of man-made radiation dose to the crew of a nuclear-powered space

vehicle was performed utilizing the MCNP radiation transport code. In addition, natural

radiation dose was incorporated using estimates previously made at the NASA Langley

Research Center. In Chapter I, the Mars mission project and its historical context were

introduced. Furthermore, the dose limits, which control any activity involved in a nuclear

radiation environment, were discussed. Chapter II provided background information on

previous dose estimates for natural space radiation, a description of the NEP vehicle, and

estimates of radiation doses for man-made sources in space missions. Chapter III

presented an overview of the methods used to assess the man-made radiation source term

used in this project. In particular, brief descriptions of TWODANT and ORIGEN2 codes

were presented, followed by the operating and post-shutdown fluxes of the scaled SP- 100

reactor. Chapter IV described the computational methods used in this project. Particularly,

the Monte Carlo method was introduced, the MCNP code was described, and the input

file of the project was analyzed. In Chapter V, the project results were presented and

discussed. Finally, in Chapter VI, a brief user's guide was presented for the skeletal

version of the computational to01 developed in this project.

The literature review highlighted some of the advantages of nuclear propulsion for

deep space missions, such as a Mars mission. It emphasized that space natural radiation

sources create a hostile environment. Consequently, the time spent in space should be

minimized and this can be done by shortening the travel time. There is currently no

comprehensive dose estimate for the NEP vehicle in the literature. In this work, the dose

variations as a function of two parameters, namely the tungsten and the lithium hydride

layer thickness of the shadow shield, were assessed.
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CONCLUSIONS

The shield thickness required to reduce the reactor dose to the crew below the 0.05 Sv y-1

limit is summarized in Table 7.1. The data indicate that a 30-cm thick tungsten layer

followed by a 55-cm thick lithium hydride layer would serve as an adequate shield

considering only the photon and neutron source terms from the reactor and its shield.

Photon production by neutron interactions in the shield have not been considered, yet the

LiH layer would probably have to be increased to further attenuate this photon component

of the crew dose.

Table 7.1 Summary of tungsten and lithium hydride thickness requirements to lower

the dose rate inside the crew compartment for the source particles below the 1.67 10 -2 Sv

y-1 limit.

W Thickness

(cm) Neutron Component

LiH Thickness (cm)

Photon Component Total

10 52 140 140

20 40 No requirement 40

30 30 No requirement 30

Because of MCNP deep penetration limitations, the dosimetry results had to be

interpolated. The study identified that photons generated by the reactor neutrons

interacting with the shield material were the main dosimetric concern. In general, the

neutron source is the major shield design concern for the SP- 100 reactor. Photons from

the reactor are easily shielded and contribute in a negligible way to the total dose as long

as the tungsten layer exceeds 15 cm in thickness.
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RECOMMENDATIONS

This study attempted to use MCNP variance reduction techniques in the most

effective manner according to the knowledge of the author. Nevertheless, these

techniques might be improved by a more experienced MCNP user. The MCNP manual

indicates that successful use of MCNP variance reduction techniques is often difficult,

tending to be more of an art than a science.

This research did not model the three reactors simultaneously, and no run

following the particles from the bottom of the reactor to the crew compartment in one

straight run was performed. This was not executed because of the computer and code

limitation. MCNP limits the user to a maximum of 99999 surfaces and 99999 cells. The

maximum number of surfaces is easily reached when the model is complex.

Nevertheless, it would be interesting to know whether the presence of the beam truss

structures could modify in any significant way the dose rates estimated in the current

model. This task would require some model simplifications. A good example would be

to model only one of the three reactors.

This work was performed with the photon and neutron source terms for an

operating SP-100 reactor at beginning of life. The next step would be to complete the

dose assessment by performing a similar study, as the one in this report, using the post-

shutdown reactor fluxes presented in previous chapters. In these cases, the only concern

would be photon sources from the decay of the fission product inventory.

The neutron cross-section libraries for tungsten available at the time the study was

performed appear to substantially overestimate the production of neutron-generated

photons. It would be highly recommended to perform the same calculations with more

recent neutron cross-sections.

Furthermore, it should be interesting to study the effects of dose rate with an

added second tungsten layer at the bottom of the shield. The purpose of this added layer

would be to attenuate all the photons generated by the neutrons inside the shield if this

indeed appears to be a concern. However, this added layer may generate additional

photons in further neutron reactions which would not be attenuated at all. Moreover, the
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materialcharacteristics,and theweight limits areother factorswhich influencetheshield

designandtheseitemswould alsohavetobeconsideredin anyfinal shieldinganalysis.

Finally, a four-layer-design of beryllium, depleted lithium hydride, tungsten, and

natural lithium hydride should be considered. This shadow shield option has been

considered by NASA Lewis researchers but it has not been adopted for this project. As a

result of the research outcomes presented in this report, it seems necessary to attenuate the

neutron flux before the tungsten layer in order to decrease the number of photons

generated by neutron interactions with tungsten.
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APPENDIX A

LIST OF ACRONYMS

AL

ALARA

ALSPE

BFO

BRYNTRN

CAM

DCF

ECCV

GCR

HZE

ICRP

IMLEO

ITS

LANL

LEO

LET

MCG

MCN

MCNP

MeV

MT

NASA

NCRP

NEP

NTP

NTR

OSHA

Anomalously Large

As Low As Reasonably Achievable

Anomalously Large Solar Particle Events

Blood Forming Organs

Baryon Transport Computer Code

Computerized Anatomical Man

Fluence-to-Dose Equivalent Conversion Factors

Earth Crew Capture Vehicle

Galactic Cosmic Rays

High atomic number (Z) and Energy particles

International Commission on Radiological Protection

Initial Mass at Low Earth's Orbit

Integrated Tiger Series

Los Alamos National Laboratory

Low Earth Orbit

Linear Energy Transfer

Monte Carlo Code for Gamma Transport

Monte Carlo Code for Neutron Transport

General Monte Carlo Code for Neutron and Photon

Transport

Mega Electron Volt, unit of energy

1 MeV = 1.6 10 -19 Joules

Metric Ton

National Aeronautics and Space Administration

National Council on Radiation Protection and

Measurements

Nuclear Electric Propulsion

Nuclear Thermal Propulsion

Nuclear Thermal Rocket

Occupational Safety and Health Administration
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SAA

SEI

SPE

SP-IO0

SSF

Sv

SouthAtlantic Anomaly

SpaceExplorationInitiative
Solar Particle Event

The reactor system employed for the NEP vehicle

Space Station Freedom

Sievert, dose Equivalent unit

1 Sv= 1Jkg -1

A-2



APPENDIX B

MCNP INPUT FILES

Appendix B.1 MCNP Neutron Runs Through the Shield.
Input File for neutron runs through the shield geometry.

HPM 1 -- NEP 25 MWTH REACTOR 1 IS MODELED -- REFLECTOR, SHIELD
C Cell Card
C Shield

1 6 -.479
2 5 -1.85
4 3 -19.3
5 3 -19.3
10 3 -19.3
16 2 -.775
17 2 -.775
18 2 -.775

19 2 -.775
20 2-.775
6
7

-1 -2 3 IMP:N=10 IMP:P=I $6 Li coolant
-4 -5 1 IMP:N=25 IMP:P=4 $5 Be reflector

-4 -7 5 IMP:N=150 IMP:P=100 $3 W photon shield
-4 -8 7 IMP:N=1000 IMP:P=100 $3 W photon shield

-4 8 -12 IMP:N=10000 IMP:P=100 $3 W photon shield
12 -4 -13 IMP:N=500000 IMP:P=400 $2 Natural LiH
13 -4 -14 IMP:N=5000000 IMP:P=500 $2 Natural LiH
14 -4 -15 IMP:N=50000000 IMP:P=600 $2 Natural LiH
15 -4 -16 IMP:N=50(0)0(0)O IMP:P=700 $2 Natural LiH
16 -4 -17 IMP:N=50(0)0(0)0_ IMP:P=800 $2 Natural LiH

0 (1:2:-3) (-1:4:17) -9 IMP:N=I IMP:P=I
0 9 IMP:N=0 IMP:P---O

C Surface Card
1 PZ 22.25

2 CZ 28.00 $29.13
3 PZ 0
4 CZ 108

5 PZ 31.79
7 PZ 41.79
8 PZ 51.79
12 PZ 61.79

9 SZ 100 250
13 PZ 70
14 PZ 80
15 PZ 90
16 PZ 100
17 PZ 110

C Data Card

C MODE Card. In this case neutron and photon modes
MODE N P

C Material Card
C declares materials for

C 2. Natural Lithium Hydride d---0.775 g/cm3
C 3. Tungsten d=19.3 g/cm3
C 5. Beryllium d=1.85 g/cm3
C 6. Liquid Lithium d=0.479 g/cm3

B-1



M2 3006.10C0.0375 3007.05C0.4625 1001.35C0.5
M3 74000.01C1
M5 4009.03C1
M6 3006.10C0.075 3007.05C0.925
C Source Card

SDEF ERG=D1 SUR=3 PAR=l VEC=0 0 1 DIR=l POS=0 0 0 RAD=D2
WGT=7.721134239E14

SI1 0.00 1.39E-I0 4.14E-7 1.67E-4 5.53E-3 4.09E-2 1.11E-1 3.02E-1 4.98E-1
8.21E-1 1.35 2.23

SP1 0 5.1359069E12 2.7980892E13 6.6769457E13 1.3500502E14 1.2020317E14
1.6045523E14 6.978537IE13 7.6679939E13 4.665485E13 3.4134922E13
2.9308666E13

SI2 0 28

C Tally Card
F2:N 123457891213141516
E2 5.00E-2 2.52E-1 1 4.5 10
F12:P 1 2 45 7 8 9 12 13 14 15 16 17
El2 .01.015.025.05.06.07.08.1.15.2.3.5 1 3 6 10
NPS 500000

PRINT -40 -150 -198
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Appendix B.2 Photon Runs Through the Shield.
MCNP Input File for photon runs through the shield geometry.

PHOTONS -- NEP 25 MWTH REACTOR 1 IS MODELED -- REFLECTOR, SHIELD
C
C
1
2

3
4
5
6
7
8
9
10
11
12
18

20
21

Cell Card
Shield
6 -.479 1 -2 -3 IMP:P=I $6 Li coolant 22.25cm
5 -1.85 -4 -5 3 IMP:P=2 $5 Be reflector 9.54 cm

3 -19.3 -4 -6 5 IMP:P=3 $3 W photon shield 33.5cm
3-19.3 -4-10 6 IMP:P=10 $3 W
3-19.3 -4-11 i0 IMP:P=50 $3
3-19.3 -4-12 I1 IMP:P=200 $3
3-19.3 -4-13 12 IMP:P=1000 $3
3-19.3 -4-1413 IMP:P=5000 $3
3-19.3 -4-15 14 IMP:P=20000 $3
3-19.3 -4-16 15 IMP:P=100000 $3
3-19.3 -4-17 16 IMP:P=500000 $3
3-19.3 -4-18 17 IMP:P=2000000 $3
2 -.775 18 -4 -20 IMP:P=16000(X)0 $2 N LiH

0 (-1:2:3)(-3:4:20)-9 IMP:P=I
0 9 IMP:P=0

C Surface Card
1 PZ 0
2 CZ 28.00
3 PZ 22.25
4 CZ 108
5 PZ 31.79
6 PZ 33
9 SZ 100 250
10 PZ 35
11 PZ 37
12 PZ 39
13 PZ 41
14 PZ 43

15 PZ 45
16 PZ 47
17 PZ 49
18 PZ 51.79

20 PZ 61.79

$ 29.13

C Data Card

C MODE Card. In this case photon mode
MODE P
C Material Card
C declares materials for

C 2. Natural Lithium Hydride d--0.775 g/cm3
C 3. Tungsten d=19.3 g/cm3

C 5. Beryllium d=1.85 g/cm3
C 6. Liquid Lithium d=0.479 g/cm3
M2 3000.01P 0.5 1000.01P 0.5
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M3 74000.01P1
M5 4000.01P1
M6 3000.01P 1
C Source Card

SDEF ERG=D 1 SUR--5 PAR=2 VEC=0 0 1 POS=0 0 0 RAD=D2
WGT=6.41443811El3
SI1 0.01.3.75 2.5 30

SP1 0 0 1.2231396E13 2.1653101E13 2.1722869E13 8.5370151E12
SI2 0 28

C Tally Card
F12:P 56910111213141516171820

El2 .01.015.025.05.06.07.08.1.15.2.3.5 1 3 6 10
NPS 200000
PRINT -40 - 150 - 198
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Appendix B.3 Neutron Runs Through the Crew Compartment.
MCNP Input File for neutron runs through the crew compartment
geometry.

CREW4 -- CREW COMPARTMENT ARGON TANKS ION THRUSTERS --
C
C
C
C
10

110
C
11
111
12
112

13
113
C
14
C
15
C
16
17
18
19

20
21
22
23
24
25
26
27
C

C
39
139
C
40
C

C
50
150
C
51
C

52

data from ntn2.4 surface 17 (W-30cm LiH-50cm)
Cell Card

Crew Compartment
Small cylinders (//to y axis)
7 -2.7 -26 27 -28 #110 IMP:P=100 $7 aluminum
0 -526 527-528 IMP:P=100 $void inside

Big cylinders (coordinate transform)
7 -2.7 -29 401 -402 #111 IMP:P=100 $7
0 -529 501 -502 IMP:P=100

7 -2.7 -30 403 -404 #112 IMP:P=100
0 -530 503 -504 IMP:P=100

7-2.7 -31 405-406 #113 IMP:P=100
0 -531 505 -506 IMP:P=100

Ion thrusters
8 -4.5 -32 33 34-35 36-37 IMP:P=10
Mars Excursion Vehicle

7-2.7 -38-39 IMP:P=50 $7 aluminum

Argon tanks (same rotation angles as big cylinders)
7-2.7 -4041 IMP:P=10
9 -1.4 -41 IMP:P=20
7-2.7 -42 43 IMP:P=10

9 -1.4 -43 IMP:P=20
7 -2.7 -44 45 IMP:P=10
9-1.4 -45 IMP:P=20

7 -2.7 -46 47 IMP:P=10
9 -1.4 -47 IMP:P=20
7-2.7 -48 49 IMP:P=10
9 - 1.4 -49 IMP:P=20
7-2.7 -50 51 IMP:P=10

9 - 1.4 -51 IMP:P=20

Second Crew Compartment
Small cylinders (//to y axis)
7 -2.7 -226 27 -28 #139 IMP:P=100 $8 aluminum
0 -626 527-528 IMP:P=100

Second Ion thrusters

8 -4.5 -32 33 234-235 -236 237 IMP:P=10

Third Crew Compartment
Small cylinders (11to y axis)
7-2.7 -326 27-28 #150 IMP:P=100 $8 aluminum
0 -726 527-528 IMP:P=100

Third Ion thrusters

8 -4.5 -32 33 334-335 336 -337 IMP:P=10
Outside world,void

0 -60 61 -62 #14 #15 #40 #51 40 42 44 46 48 50 (26:-27:28)

(29:-401:402) (30:-403:404) (31 :-405:406) (226:-27:28)
(326:-27:28) IMP:P=I
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53 0 60:-61:62 IMP:P=0

C SurfaceCard
C First SmallCylinder
C A cylinder of radius 200, Ily, x'--0, z'=9.22m
26 C/Y 0 1022 200
526 C/Y 0 1022 196.3

C A plane at y = 500
27 PY 500
527 PY 503.7

C A plane at y = 900
28 PY 900
528 PY 896.3

C Big Cylinders (Crew compartment)
C A cylinder of radius 200,//z',TRANSLATION, rotation (zz'0=150, TR1)
29 1 CZ 200
529 1 CZ 196.3
401 1PZ451
402 1 PZ 1701
501 1PZ 454.7
502 1 PZ 1697.3

C A cylinder of radius 200, I/x, axis at z=-561
30 C/X 700 -600 200
530 C/X 700-600 196.3
403 PX -625
404 PX 625
503 PX -621.3
504 PX 621.3

C A cylinder of radius 200,/Z, translation, rotation (30, TR6)
31 6 CZ 200
531 6CZ 196.3
405 6 PZ -1701
406 6 PZ-451

505 6 PZ-1697.3
506 6 PZ -454.7
C Ion Thrusters

C A plane at y = -750
32 PY-750

C A plane at y =-800
33 PY-800

C A plane at x = -250
34 PX-250

C A plane at x = 250
35 PX 250

C A plane at z = 300
36 PZ 300

C Aplaneat z =400
37 PZ 400
C ECCV

C A cone: y axis, origin (0,700,0), angle 30, 6.5m tall
38 KY 700 0.333 1

C Aplaneaty = 1350
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39 PY 1350
C Argon Tanks
C A sphere 4.0064m in diam
40 3 SZ 850 200.32

C Inside sphere 3.8m in diam
41 3 SZ 850 190

C A sphere 4.0064m in diam
42 3 SZ 1290 200.32

C Inside sphere 3.8m in diam
43 3 SZ 1290 190

C A sphere 4.0064m in diam
44 7 SX -220 200.32

C Inside sphere 3.8m in diam
45 7 SX -220 190

C A sphere 4.0064m in diam
46 7 SX 220 200.32

C Inside sphere 3.8m in diam
47 7 SX 220 190

C A sphere 4.0064m in diam
48 4 SZ -850 200.32

C Inside sphere 3.8m in diam
49 4SZ -850 190

C A sphere 4.0064m in diam
50 4 SZ -1290 200.32

C Inside sphere 3.8m in diam
51 4SZ -1290 190

C A Cylinder defining the outside world
60 CZ 1500
61 PZ -3000
62 PZ 12500
C
226 5 C_JY 0-1150200
626 5 C/Y 0-1150 196.3

234 5 PX -250
235 5 PX 250
236 5 PZ -300
237 5 PZ -400
326 2 C/Y 0 1150 200
726 2 C/Y 0 1150 196.3
334 2 PX -250
335 2 PX 250
336 2 PZ 300
337 2 PZ 400

C Data Card

C MODE Card. In this case neutron and photon modes
MODE N P
C Transformations

TR1 0 700 1200 3J 0 1 0 0.5 0 -0.866 $150# translation (big cylind)
TR2 0 0 0 3J0 1 00.866 0-0.5 $120#

TR3 0 0 1252 3J 0 1 0 0.5 0 -0.866 $150# and transl (At tanks 40-43)
TR4 0 0 1252 0.866 0 -0.5 0 1 0 $ 30# and translation (Ar tank 48-50)
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TR5
TR6
TR7
C
C

C
C
C
M7
M8
M9

C

0 700 1200 0.866 0 -0.5 0 1 0
0 0 -600

Material Card
declares materials for

7. Aluminum d=2.7 g/cm3
8. Titanium d--4.5 g/cm3

9. Liquid Argon d= 1.4 g/cm3
13027.35C 1
22000.35C 1
18000.01C 1

Source Card

000 .50-.866010 $60#(3rdbeam)

$ 30# and translation (big cylind)

SDEF ERG=D1 PAR=I VEC=0 0 -1 DIR=D2 POS=0 0 12384.09
WGT= 9.65097E+00

SI1 0.00 5.00E-2 2.52E-1 1 4.5 10

SP1 0 5.90795E+0 1.25498E+0 1.71952E+0 7.68520E-01 0
SI2 0.988 1
SP2 0 0 1

C Tally Card
F4:N 110 111 112 113 139 150 T
E4 5.00E-2 2.52E-1 1 4.5 10

F14:P 110 111 112 113 139 150 T
El4 .01.015.025.05.06.07.08.1.15.2.3.5 1 3 6 10
NPS 500000
PRINT
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Appendix B.4 Photon Runs Through the Crew Compartment.
MCNP Input File for photon runs through the crew compartment
geometry.

C
30 cm of W 50 cm of LiH

C data from ntn2.4 surface 17
C Cell Card

C Crew Compartment

C Small cylinders (11 to y axis)
10 7-2.7 -26 27-28 #110 IMP:P=100
I10 0 -526 527-528 IMP:P=100

C Big cylinders (coordinate transform)
11 7 -2.7 -29 401 -402 #111 IMP:P=100 $7
111 0 -529 501 -502 IMP:P=100
12 7 -2.7 -30 403 -404 #112 IMP:P=100
112 0 -530 503-504 IMP:P=100
13 7-2.7 -31 405 -406 #113 IMP:P=100
113 0 -531 505-506 IMP:P=100
C Ion thrusters

14 8-4.5 -32 33 34-35 36-37 IMP:P=10
C Mars Excursion Vehicle

15 7 -2.7 -38 -39 IMP:P=50 $7 aluminum

C Argon tanks (same rotation angles as big cylinders)
16 7-2.7 -40 41 IMP:P=10
17 9 - 1.4 -41 IMP:P=20
18 7-2.7 -42 43 IMP:P=10
19 9 -1.4 -43 IMP:P=20
20 7-2.7 -44 45 IMP:P=10
21 9-1.4 -45 IMP:P=20
22 7-2.7 -46 47 IMP:P=I0
23 9-1.4 -47 IMP:P=20
24 7-2.7 -48 49 IMP:P=10
25 9-1.4 -49 IMP:P=20

26 7-2.7 -50 51 IMP:P=10
27 9-1.4 -51 IMP:P=20

C Second Crew Compartment
C Small cylinders (11to y axis)
39 7-2.7 -226 27 -28 #139 IMP:P=100
139 0 -626 527-528 IMP:P=100
C Second Ion thrusters
40 8 -4.5 -32 33 234 -235 -236 237 IMP:P=10

C Third Crew Compartment
C Small cylinders (11 to y axis)

CREW 1 -- CREW COMPARTMENT ARGON TANKS ION THRUSTERS --

$7 aluminum
$void inside

$8 aluminum

50 7 -2.7 -326 27 -28 #150 IMP:P=100 $8 aluminum
150 0 -726 527-528 IMP:P=100
C Third Ion thrusters

51 8-4.5 -32 33 334-335 336-337 IMP:P=10
C Outside world,void

52 0 -6061 -62#14#15#40#51 4042444648 50 (26:-27:28)
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53

(29:-401:402)(30:-403:404)(31:-405:406)(226:-27:28)
(326:-27:28) IMP:P=I
0 60:-61:62 IMP:P=0

C SurfaceCard

C First Small Cylinder
C A cylinder of radius 200, I/y, x'=0, z'=9.22m
26 C/Y 0 1022 200
526 C/Y 0 1022 196.3

C A plane at y = 500
27 PY 500
527 PY 503.7

C A plane at y = 900
28 PY 900
528 PY 896.3

C Big Cylinders (Crew compartment)
C A cylinder of radius 200,//z',TRANSLATION, rotation (zz'0=150, TR1)
29 1 CZ 200
529 1 CZ 196.3
401 1PZ 451
402 1 PZ 1701
501 1 PZ 454.7
502 1 PZ 1697.3

C A cylinder of radius 200, I/x, axis at z=-561
30 C/X 700 -600 200

530 C/X 700-600 196.3
403 PX -625
404 PX 625

503 PX -621.3
504 PX 621.3

C A cylinder of radius 200,/Z,translation, rotation (30, TR6)
31 6 CZ 200
531 6CZ 196.3
405 6 PZ-1701

406 6 PZ-451
505 6 PZ -1697.3
506 6 PZ -454.7
C Ion Thrusters

C A plane at y = -750
32 PY -750

C A plane at y = -800
33 PY-800

C A plane at x = -250
34 PX -250

C Aplaneatx =250
35 PX 250

C Aplaneatz=300
36 PZ 300

C A plane at z = 400
37 PZ 400
C ECCV

C A cone: y axis, origin (0,700,0), angle 30, 6.5m tall
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38 KY 700 0.333 1

C A plane at y = 1350
39 PY 1350

C Argon Tanks
C A sphere 4.0064m in diam
40 3 SZ 850 200.32 "

C Inside sphere 3.8m in diam
41 3 SZ 850 190

C A sphere 4.0064m in diam
42 3 SZ 1290 200.32

C Inside sphere 3.8m in diam
43 3 SZ 1290 190

C A sphere 4.0064m in diam
44 7 SX -220 200.32

C Inside sphere 3.8m in diam
45 7SX -220 190

C A sphere 4.0064m in diam
46 7 SX 220 200.32

C Inside sphere 3.8m in diam
47 7SX 220 i90

C A sphere 4.0064m in diam
48 4 SZ -850 200.32

C Inside sphere 3.8m in diam
49 4SZ -850 190

C A sphere 4.0064m in diam
50 4 SZ -1290 200.32

C Inside sphere 3.8m in diam
51 4SZ -1290 190

C A Cylinder defining the outside world
60 CZ 1500
61 PZ -3000
62 PZ 12500

C
226 5 C/Y 0-1150200
626 5 C/Y 0-1150 196.3
234 5 PX -250
235 5 PX 250
236 5 PZ -300
237 5 PZ -400
326 2 C/Y 0 1150200

726 2 C/Y 0 1150 196.3
334 2 PX -250
335 2 PX 250
336 2 PZ 300
337 2 PZ 400

C Data Card

C MODE Card. In this case photon mode
MODE P

C Transformations

TR1 0 700 1200 3J 0 1 0 0.5 0 -0.866 $150# translation (big cylind)
TR2 000 3J0 1 00.8660-0.5 $120#
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TR3
TR4
TR5
TR6 0 700 1200 0.866 0 -0.5 0 1 0
TR7 0 0 -600
C Material Card
C declares materials for

C 7. Aluminum d=2.7 g/cm3
C 8. Titanium d--4.5 g/cm3
C 9. Liquid Argon d-1.4 g/cm3
M7 13000.01P 1
M8 22000.01P 1
M9 18000.01P 1
C Source Card
SDEF

SI1
SP1

0 0 1252 3J 0 1 0 0.5 0 43.866 $150# and transl (Ar tanks 40-43)
0 0 1252 0.866 0 43.5 0 1 0 $ 30# and translation (Ar tank 48-50)
0 0 0 .5 0 -.866 0 1 0 $ 60# (3rd beam)

$ 30# and translation (big cylind)

SI2
SP2
C
F14:P 110 111 112 113 139 150 T
E14 .01.015.025.05.06.07.08 .I .15.2.3.5 1 3 6 10
NPS 2000000
PRINT

ERG=D1 PAR=2 VEC=0 0 -1 DIR=D2 POS=0 0 12384.09
WGT=2.08428E+06

0.01.015.025.05.06.07.08.1.15.2.3.5 1 3 6 10
0 8.42663E+02 2.07116E+04 1.70104E+05 3.35592E+05 8.15307E+04

6.51968E+04 5.29651E+04 9.04114E+04 1.41051E+05 9.14781E+04
1.21780E+05 1.76617E+05 2.19369E+05 3.73527E+05 1.30622E+05
1.24789E+04

0.988 1
001

Tally Card
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- APPENDIX C

MCNP OUTPUT FILES

Appendix C.l° Example of Neutron Tally
Surface flux for various energy bins.

surface 1

energy
5.0000E-02
2.5200E-01
1.0000E+O0
4.5000E+00
1.0000E+01

total

2.74347E+10 0.0027
1.05833E+10 0.0041
4.68495E+09 0.0063
9.08039E+08 0.0130
0.00000E+00 0.0000

4.36110E+10 0.0021
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Appendix C°l° Example of Photon Tally
Surface flux for various energy bins.

surface 1

energy
1.0000E-02 4.66268E+05 0.8291
1.5000E-02 1.94170E+07 0.4581
2.5000E-02 1.14973E+08 0.1691
5.0000E-02 6.56650E+08 0.08??
6.0000E-02 2.26439E+08 0.0802
7.0000E-02 2.05652E+08 0.0812
8.0000E-02 1.93850E+08 0.0950
1.0000E-01 3.98321E+08 0.0817
1.5000E-01 6.53421E+08 0.05?9

2.0000E-01 4.57823E+08 0.090?
3.0000E-01 6.21146E+08 0.0493
5.0000E-01 8.98456E+08 0.0469
1.0000E+O0 8.53329E+08 0.0582
3.0000E+00 1.57062E+09 0.0219
6.0000E+00 5.30791E+08 0.032?
1.0000E+O 1 9.72476E+07 0.0699

total 7.49860E+09 0.0202
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- APPENDIX D

CURVE FITS
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A:'_D_%, + Curve fit dose cell 110 WlO
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Figure D.a Curve fit of the photon dose rates inside the six crew compartments due to

one SP-100 reactor neutron interactions through the shield with a 10-cm thick tungsten

layer and a variable lithium hydride thickness.
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Figure D.b Curve fitof the photon dose ratesinsidethe six crew compartments due to

one SP-100 reactorneutron interactionsthrough the shieldwith a 20-cm thick tungsten

layerand a variablelithiumhydride thickness.
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Figure D.e Curve fit of the photon dose rates inside the six crew compartments due to

one SP-100 reactor neutron interactions through the shield with a 30-cm thick tungsten

layer and a variable lithium hydride thickness.

D-3





Form Approved

REPORT DOCUMENTATION PAGE OMBNo. 0704-0188

Public re_oorlingburden Io¢ this colleczion¢d informmJonis estimated to average 1 hourper rexponse, includingthe time for revmmng instructions,searching existingdata sources,
gathering and mmntaining1hed&ta nee0ed, and completing and rev=ewing1he collectionnf information. Send comments regarding this burden estimate o¢ any o(her upecl nf this
collection of information,includingsuggestions for reciucingthis burden, to WashingtonHeadquartersServioN, Directorate for InformationOperations and Reoorts, 1215 Jefferlon
Davis Highway, Suite 1204, Arlingtoct.VA 22202-4302, and Io the Offio=ol Management and Budget. Paperwork ReductionProject (0704-0188). Washington, DC 20503.

1. AGENCY USE ONLY (Leave blank) 2. REPORT DATE 3. REPORT TYPE AND DATES COVERED

February 1996 Final Contractor Report

4. TITLE AND SUBTITLE

Investigation of Natural and Man-Made Radiation Effects on Crews on Long
Duration Space Missions

8. AUTHOR(S)

Wesley E. Bolch and Alexander Parlos

7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)

Texas A&M University

Department of Nuclear Engineering
College Station, Texas 77843-2124

9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES)

National Aeronautics and Space Administration
Lewis Research Center

Cleveland, Ohio 44135-3191

5. FUNDING NUMBERS

WU-506-31-3 M

G-NAG3-1326

8. PERFORMING ORGANIZATION
REPORT NUMBER

E-9371

10. SPONSORING/MONITORING
AGENCY REPORTNUMBER

NASA CR-195424

11. SUPPLEMENTARYNOTES

Project Manager, Steven M. Stevenson, Advanced Space Analysis Office, NASA Lewis Research Center, organization
code 6840, (216) 977-7087.

12a. DISTRIBUTION/AVAILABILITY STATEMENT

Unclassified - Unlimited

Subject Categories 52 and 91

This publication is available from the NASA Center for Aerospace Information, (301) 621--0390.

12b. DISTRIBUTION CODE

13. ABSTRACT (Maximum200 words)

Over the past several years, NASA has studied a variety of mission scenarios designed to establish a permanent human presence on the

surface of Mars. Nuclear Electzic Propulsion (NEP) is one of the possible designs for this program. During the initial stages of vehicle

design work, careful consideration must be given to, not only the shielding requirements of natural space radiations, but to the shielding

and configuration requirements of the on-board reactors. In this work, the radiation transport code MCNP has been used to make initial

estimates of crew exposures to reactor radiation fields for a specific manned NEP vehicle design. In this design, three 25 MW t sealed

SP-100-class reactor radiations are shielded by three identical shields. Each shield layers beryllium, tungsten, and lithium hydride

between the reactor and the crew compartment. Separate calculations are made of both the exiting neutron and gamma fluxes from the

reactors during beginning-of-life, full-power operation. This data is then used as the source terms for particle transport in MCNP. The

total gamma and neutron fluxes exiting the reactor shields are recorded and separate transport calculations are then performed for a

10 gem -2 crew compartment aluminum thickness. Estimates of crew exposures have been assessed for various thicknesses of the shield

tungsten and lithium hydride layers. A minimal tungsten thickness of 20 cm is required to shield the reactor photons below the 0.05 Sv

y-I man-made radiation limit. In addition to a 20-cm thick tungsten layer, a 40-era thick lithium hydride layer is required to shield the

reactor neutrons below the annual limit. If the tungsten layer is 30-cm thick, the lithium hydride layer should be at least 30--era thick.

These estimates do not take the photons generated by neutron interactions inside the shield into account because the neutron MCN'P

cross sections do not as yet allow reliable estimates of photon production in these materials. These results, along with natural space

radiation shielding estimates calculated at NASA Langley, have been used to provide preliminary input data into a new MacIntosh-based

radiation exposure analysis tool developed at Texas A&M. A skeletal version of the tool now being developed will allow soon rapid

radiation exposure and risk analyses to be performed on a variety of Lunar and Mars missions utilizing a nuclear-power vehicles.

14. SUBJECT TERMS 15. NUMBER OF PAGES

Radiation/space missions; NEP; NTR vehicles

17. SECURITY CLASSIFICATION
OF REPORT

Unclassified

18. SECURITY CLASSIFICATION

OF THIS PAGE

Unclassified

19. SECURITY CLASSIFICATION

OF ABSTRACT

Unclassified

134

16. PRICE CODE

A07

20. LIMITATION OF ABSTRACT

NSN 7540-01-280-5500 Standard Form 298 (Rev. 2-89)

Prescribed by ANSI Sld. Z39-18
298-102







qUl

..--.i


